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1 Introduction

About this chapter
This chapter contains important user information, descriptions of safety notices,
intended use of the UniFlux™ 10 system and a list of associated documentation.

In this chapter

Section See page

1.1 About this manual 6

1.2 Important user information 7

1.3 Associated documentation 9

1.4 Abbreviations 10
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1.1 About this manual

Purpose of this manual
The Operating Instructions provide you with the information needed to install, operate,
and maintain the product in a safe way.

Scope of this manual
This Operating Instructions covers all variants of UniFlux 10 system.

The components included in the configuration are described in the General Specifica-
tion (GS). Classification information for your system is described on the system label.

Typographical conventions
Software items are identified in the text by bold italic text.

Hardware items are identified in the text by bold text.

In electronic format, references in italics are clickable hyperlinks.

1 Introduction
1.1 About this manual
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1.2 Important user information

Read this before operating the
product

All users must read the entire Operating Instructions before installing, oper-
ating or maintaining the product.

Always keep the Operating Instructions at hand when operating the product.

Do not operate the product in any other way than described in the user documenta-
tion. If you do, you may be exposed to hazards that can lead to personal injury and you
may cause damage to the equipment.

Intended use of UniFlux 10 system
UniFlux 10 system is intended for pilot to production scale biological separations.

The systems are configured to operate hollow fiber cartridges suited for microfiltration
applications such as cell clarification/harvesting, or cassettes/hollow fibers for ultrafil-
tration applications, such as protein concentration and diafiltration in downstream
unit operations.

UniFlux 10 system shall not be used in any clinical procedures, or for diagnostic
purposes.

UniFlux 10 system shall not be used for operation in a potentially explosive atmosphere
or for handling flammable liquids.

WARNING

Do not operate the product in any other way than described in the
user documentation.

1 Introduction
1.2 Important user information
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Prerequisites
In order to operate UniFlux 10 system in a safe way, and according to the intended
purpose, the following prerequisites must be met:

• You should be acquainted with the use of bioprocessing equipment and with the
handling of biological materials.

• You must have read and understood the Safety chapter of these Operating Instruc-
tions.

• The system must be installed according to the instructions in Chapter 4 Installation,
on page 78.

• You must have a working knowledge of the UNICORN™ software. Refer to the
UNICORN manuals for instructions on the software structure and the work flow.

Safety notices
This user documentation contains safety notices (WARNING, CAUTION, and NOTICE)
concerning the safe use of the product. See definitions below.

WARNING

WARNING indicates a hazardous situation which, if not avoided,
could result in death or serious injury. It is important not to proceed
until all stated conditions are met and clearly understood.

CAUTION

CAUTION indicates a hazardous situation which, if not avoided,
could result in minor or moderate injury. It is important not to
proceed until all stated conditions are met and clearly understood.

NOTICE

NOTICE indicates instructions that must be followed to avoid
damage to the product or other equipment.

Notes and tips
Note: A note is used to indicate information that is important for trouble-free and

optimal use of the product.

Tip: A tip contains useful information that can improve or optimize your proce-
dures.

1 Introduction
1.2 Important user information
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1.3 Associated documentation

System-specific documentation
In addition to the Operating Instructions, the documentation package supplied with
the UniFlux 10 system also includes product documentation binders containing
detailed specifications and traceability documents. The most important documents in
the document package with regard to technical aspects of the UniFlux 10 system are:

Document Abbrevia-
tion

Purpose/Contents

Piping and Instrumen-
tation Diagram

P&ID Schematic overview of the entire
process flow, all components and
instruments and the control system.

General Specification GS Technical data for the system.

Assembly Drawing AD Physical layout. Provides all dimen-
sional data.

Bill of Material BOM Detailed specifications for process
related components.

Declaration of
Conformity

DoC EU declaration of conformity.

Spare Part List SPL List of spare parts available from Cytiva.

Software documentation
Together with each system, the following software documentation is supplied
providing additional information that applies to UniFlux 10 system, independent of the
specific configuration:

Document Purpose/Contents

UNICORN™ manual package • The manuals contain detailed instructions on
how to administer UNICORN, work with
methods, perform runs and evaluate results.

• The Online help contains dialog descriptions for
UNICORN. The Online help is accessed from the
Help menu.

Component documentation
Documentation for components produced both by Cytiva and by a third-party are, if
existent, also included in the product documentation package.

1 Introduction
1.3 Associated documentation
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1.4 Abbreviations

Introduction
This section explains abbreviations that appear in the user documentation for UniFlux
10.

Abbreviations

Abbrevia-
tion

Definition (English) Translation

EPDM Ethylene Propylene Diene
Monomer

Ethylene Propylene Diene
Monomer

HEPA High Efficiency Particulate Air High Efficiency Particulate Air

PID Proportional Integral Deriva-
tive

A PID controller calculates an
error value as the difference
between a measured process
variable (PV) and a desired
setpoint (SP). The PID
controller attempts to mini-
mize the error by adjusting the
process control inputs (CV).

Proportional Integral Deriva-
tive

A PID controller calculates an
error value as the difference
between a measured process
variable (PV) and a desired
setpoint (SP). The PID
controller attempts to mini-
mize the error by adjusting the
process control inputs (CV).

PLC Programmable logic controller Programmable logic controller

PV Process variable, measured Process variable, measured

SP Setpoint

The target value that an auto-
matic control system, for
example PID controller, will
attempt to reach by adjusting
the process control inputs.

Setpoint

The target value that an auto-
matic control system, for
example PID controller, will
attempt to reach by adjusting
the process control inputs.

TC-clamp Hygienic tubing connection
clamp

Hygienic tubing connection
clamp

UPS Uninterruptible power supply Uninterruptible power supply

1 Introduction
1.4 Abbreviations
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2 Safety instructions

About this chapter
This chapter describes safety precautions, emergency shutdown procedures and
labels information for UniFlux 10

In this chapter

Section See page

2.1 Safety precautions 12

2.2 Labels 22

2.3 Emergency procedures 25

Important

WARNING
Before installing, operating or maintaining the product, all
users must read and understand the entire contents of this
chapter to become aware of the hazards involved.

2 Safety instructions
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2.1 Safety precautions

Introduction
The safety precautions in this section are grouped in the following categories:

• General precautions on page 12

• Flammable liquids and explosive environment, on page 14

• Personal protection on page 14

• Installing and moving on page 15

• Power supply, on page 18

• System operation on page 18

• Maintenance on page 20

Note: Some of the safety precautions in this chapter may concern components or
situations described in other UniFlux 10 product documents.

General precautions

WARNING

Risk assessment. Perform a risk assessment for any risks due to
the process or process environment. Evaluate the effects the use of
the product and the operational processes may have on the classi-
fication of the hazardous area. The process might cause the area to
increase or the zone classification to change. Implement the risk
reduction measures needed, including use of personal protective
equipment.

WARNING

The customer must make sure that all installation, maintenance,
operation and inspection is carried out by qualified personnel who
are adequately trained, understand and adhere to local regulations
and the operating instructions, and have a thorough knowledge of
the product and the entire process.

WARNING

Do not operate the product in any other way than described in the
user documentation.

2 Safety instructions
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WARNING

Protective earth. The product must always be connected to
protective earth when energized.

WARNING

Do not use UniFlux 10 system if it is not working properly, or if it has
suffered any damage, for example:

• damage to the power cord or its plug

• damage caused by dropping the equipment

• damage caused by splashing liquid onto it

WARNING

Only authorized personnel may open the electrical cabinet doors.
There is hazardous voltage inside the electrical cabinet that can
cause human injury or death.

WARNING

The electrical cabinet doors may only be opened when the product
is taken out of operation and subject to LOCK OUT / TAG OUT
(LOTO) (lockout-tagout).

CAUTION

Hot surface. When pumping fluid through the system that has a
temperature above the normal working temperature, do not touch
the system until you are sure that this can be done without risk and
when all components in the system have reached the normal
working temperature range.

CAUTION

Do not insert your fingers or other objects into fans or other
moving parts.

2 Safety instructions
2.1 Safety precautions
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Flammable liquids and explosive
environment

WARNING

Flammable liquids. This product is not approved to handle flam-
mable liquids.

WARNING

Explosive environment. The product is not approved for work in
a potentially explosive atmosphere. The product does not fulfill the
requirements of the ATEX Directive.

Personal protection

WARNING

Hazardous substances and biological agents. When using
hazardous chemical and biological agents, take all suitable protec-
tive measures, such as wearing protective clothing, glasses and
gloves resistant to the substances used. Follow local and/or
national regulations for safe operation and maintenance of UniFlux
10 system.

WARNING

Personal Protective Equipment (PPE). Whenever packing,
unpacking, transporting or moving the system, wear protective
footwear, preferably with steel toe caps.

WARNING

High pressure. The product operates under high pressure. Wear
protective glasses and other required Personal Protective Equip-
ment (PPE) at all times.

2 Safety instructions
2.1 Safety precautions
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Installing and moving

WARNING

The product must be installed and prepared by Cytiva personnel or
a third party authorized by Cytiva.

WARNING

Move transport crates. Make sure that the lifting equipment has
the capacity to safely lift the crate weight. Make sure that the crate
is properly balanced so that it will not accidentally tip when moved.

WARNING

The system is not fitted with lifting eye bolts or other equipment for
lifting with telphers or similar equipment. The system should only
be lifted using the lower part of the frame.

WARNING

Heavy object. Because of the significant weight of the product,
great care must be taken not to cause squeezing or crushing inju-
ries during movement. At least two, but preferably three or more,
people are recommended when moving the unit.

WARNING

Heavy object. The ramp is not reinforced in the center. Do not use
a pallet lifter or forklift on the ramp.

WARNING

Heavy object. When rolling the system down the ramp take great
care to avoid the wheels slipping off the edge of the ramp.

2 Safety instructions
2.1 Safety precautions

UniFlux 10 Operating Instructions 28993587 AF 15



WARNING

Access to power switch and power cord with plug. Do not
block access to the power switch and power cord. The power switch
must always be easy to access. The power cord with plug must
always be easy to disconnect.

WARNING
Fixed power supply: Access to power switch and isolation
switch. The power switch and the isolation switch must always be
easy to access.

WARNING

When the system is operated from a remote controlling computer,
the operator must always make sure that no one is present and
exposed when the system is started and that no one enters the risk
area around the system during operation.

CAUTION

The wheels of the product must be locked during normal use. The
wheels must be unlocked only when moving the unit.

CAUTION

Make sure that all tubing, hoses and cables are placed so that the
risk of tripping accidents is minimized.

CAUTION

The product is designed for indoor use only.

CAUTION

Do not use the product in a dusty atmosphere or close to spraying
water.

2 Safety instructions
2.1 Safety precautions
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CAUTION

Make sure that correct air pressure is always maintained. Too high
or too low air pressure may be hazardous and may cause erroneous
results and leakage.

CAUTION

Before moving the UniFlux 10 system, make sure that:

1. The power supply to the system is switched off.

2. All power cords to the systems are disconnected.

3. All air supply lines to the systems are disconnected.

4. All process lines to the systems are disconnected.

5. All communication cables to the systems are disconnected.

CAUTION

Make sure that the common waste outlet is:

• Never exposed to back-pressure.

• Connected to piping with at least the same diameter as the
common waste outlet piping.

• Connected to piping that allows maximum waste flow to be
transported away from the product without pooling.

CAUTION

Use the supplied network cable with encased RJ45 connectors to
protect from liquids. Do not replace this cable with an unprotected
cable.

CAUTION

To prevent bacterial growth, the product may be partly filled with
denatured alcohol (18% C2H5OH (ethanol), 2% C3H7OH (isopro-
panol) and 80% H2O (water)) at delivery.

The denatured alcohol mixture can be hazardous to humans
if consumed.

Flush out the denatured alcohol before assembling, testing or inte-
grating the product into the intended process context.

2 Safety instructions
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NOTICE

Any computer used with the equipment must comply with EN/IEC
60950-1, and be installed and used according to the manufactur-
er's instructions.

Power supply

WARNING

Protective ground. The product must always be connected to a
grounded power outlet.

WARNING

National Codes and standards (NEC, VDE, BSI, IEC, UL etc.) and local
codes outline provisions for safely installing electrical equipment.
Installation must comply with specifications regarding wire types,
conductor sizes, plugs, branch circuit protection and disconnect
devices. Non-compliance may result in personal injury and/or
equipment damage.

WARNING

All electrical installations must be performed by authorized
personnel only.

CAUTION

Connection of an external Uninterruptible Power Supply (UPS)
(uninterrupted power supply) for system operation shall only be
performed by authorized personnel to avoid mismatching or
connection errors. Contact your local Cytiva representative for
more information.

System operation

WARNING

Safe distance. Always maintain a safe distance from UniFlux 10
system during drainage or other activities that may involve
splashing.

2 Safety instructions
2.1 Safety precautions
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WARNING

During operation, all cabinet doors must be closed and locked.

WARNING

Before operation, all process connections and the piping system
must be tested for leakage at maximum pressure for continued
protection against injury risks due to fluid jets, burst pipes or
potentially explosive atmosphere.

WARNING

Use a harmless fluid in the beginning of the process. This will make
it possible to detect leakage with minimized consequences and the
risk for potential leakage of hazardous fluids is avoided.

WARNING

Never exceed the operating limits stated in this document and on
the system label. Operation of the product outside these limits can
damage equipment and cause personal injury or death.

WARNING

Power failure - equipment may remain pressurized. During a
power failure, or if the EMERGENCY STOP button is pressed, the
equipment may remain pressurized. Opening a line or vessel at this
point could result in the release of potentially hazardous process or
cleaning fluid, and cause bodily harm.

When recovering from a power failure or emergency shutdown,
make sure all lines and vessels are depressurized before opening.

WARNING

Shutdown does not automatically result in depressurizing of the
piping system.

2 Safety instructions
2.1 Safety precautions
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WARNING

Emergency stop. Pressing the EMERGENCY STOP will not shut
off mains power to the electrical cabinet.

WARNING

Alarm signals. All alarm signals must be set within the limits
specified in the system documentation. Pressure and temperature
control must be activated while the system is in use to prevent
leakage or damage to the piping system.

WARNING

Alarm signals. Make sure to change back to the original alarm
level after UNICORN for BioProcess alarm buzzer test.

CAUTION

Make sure that the pH probe is mounted correctly after reas-
sembly.

CAUTION

The operator must always make sure that no one is present and
exposed before energizing the hydraulic pump.

Maintenance

WARNING

Decontaminate before service. Before performing any service
work on the system, make sure that the system has been properly
decontaminated.

2 Safety instructions
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WARNING

LOCK OUT / TAG OUT (LOTO)! Before any maintenance or
decommissioning work is performed on the system, make sure
that:

• the system is empty and depressurized.

• the system is disconnected from process feed, electrical power
and pneumatic supply.

• the system is prevented from accidentally becoming re-ener-
gized during maintenance.

• the system is clearly tagged as taken out of operation.

• all process wetted areas are clean and decontaminated.

WARNING

Only personnel authorized by Cytiva may perform service, installa-
tion, and maintenance of components inside the electrical cabinet
of the system.

WARNING

Use only approved parts. Only spare parts and accessories that
are approved or supplied by Cytiva may be used for maintaining or
servicing the product.

WARNING

For continued protection against injury risks due to fluid jets, burst
pipes or potentially explosive atmosphere, the user must test the
piping system for leakage at maximum operating pressure.

• Always perform a leakage test after assembly or maintenance.

• Always perform a leakage test before operation or CIP.

2 Safety instructions
2.1 Safety precautions
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2.2 Labels

Introduction
This section describes the various labels on the UniFlux 10 system and their meaning.

System label
The system label is located on the back of the equipment. The system label identifies
the equipment and shows electrical data, regulatory compliance, and warning
symbols.

Description of symbols on the system
label

Label Meaning

Serial
number

System serial number

Manufac-
turing Year/
Month

Year (YYYY) and month (MM) of manufacture

Max system
pressure/
temperature

Max system pressure at temperature

Pneumatic
supply

Pneumatic supply pressure requirement

Overall
protection
class

Overall protection class, ingress protection according to IEC
60529. This cover all components of the system including the
electric cabinet

Supply
voltage

Supply voltage system

Supply
voltage
motor

Supply voltage motor

Frequency Supply voltage frequency

Max current
consumption
system

Max current consumption system

Max current
consumption
motor

Max current consumption motor

2 Safety instructions
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Safety labels
The table below describes the various safety labels that may be found on UniFlux 10.

Symbol/text Description

Warning! Read the user documentation before using
the system. Do not open any covers or replace parts
unless specifically stated in the user documentation.

Warning! High Voltage

Always make sure that the system is disconnected
from electric power before opening the cabinet doors
or disconnecting any electric device.

Warning! Hot surface

Risk of burning injuries.

Warning! Crush injury risk area

Keep fingers and other body parts away from moving
components.

Warning!

Risk of spraying fluid jets.

WARNING! Max operating pressure as stated on the
label.

For continued protection
against fire replace only with
same type and rating of fuse

High voltage inside cabinet!
Authorised personnel only!

WARNING! WARNING! High voltage inside cabinet!

Authorized personnel only! For continued protection
against fire, only replace fuses with the same type and
rating.

2 Safety instructions
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Symbol/text Description

Warning! Before connecting the system, make sure
that the system setting corresponds with the power
supply.

Disconnect switch and branch circuit to be provided
by installer.

NOTE!

Different power supply cables in CE/UL systems

CE UL

P 1 Brown

N 2 White

Protective
earth

Yellow/green Green or
Yellow/green

Make sure that authorized personnel perform elec-
trical connections and use appropriate power supply
plug.

EMERGENCY STOP label, yellow with black text.
(emergency stop button is red).

Refer to Section 2.3 Emergency procedures, on page
25 for further information regarding the emergency
stop.

IMPORTANT! Before service/maintenance or return
to Cytiva, clean the equipment and accompany it with
a decontamination statement, specifying substances
with which it has been in contact during use and the
method of cleaning.

CAUTION! Pressure control valve shall be set to 6 bar
g for instrument air supply.

Use ear protection whenever working close to the
system in operation.

2 Safety instructions
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2.3 Emergency procedures

Introduction
Under normal circumstances, the UniFlux 10 system should always be shut down as
described in Section 5.4 Procedures after usage, on page 114.

Shutting down the UniFlux 10 system by pressing the EMERGENCY STOP button
should only be performed if an emergency situation prevents normal shutdown.

This section describes how to perform an emergency shutdown of the UniFlux 10
system, the result in the event of power failure, and the procedure for restarting the
UniFlux 10 system after a power failure.

Precautions

WARNING

Emergency stop. Pressing the EMERGENCY STOP will not shut
off mains power to the electrical cabinet.

WARNING

Power failure - equipment may remain pressurized. During a
power failure, or if the EMERGENCY STOP button is pressed, the
equipment may remain pressurized. Opening a line or vessel at this
point could result in the release of potentially hazardous process or
cleaning fluid, and cause bodily harm.

When recovering from a power failure or emergency shutdown,
make sure all lines and vessels are depressurized before opening.

Emergency stop button and main
power switch

2 Safety instructions
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Part Function

A EMERGENCY STOP button

B MAIN SWITCH, power

Emergency shutdown

Step Action

1 Press the EMERGENCY STOP button (A).

Result:

• All motors and externally moving components stop immediately.

• No data is lost.

2 If required, also switch off the MAIN SWITCH (B), disconnect the power cord
or switch off the fixed power supply circuit breaker.

Result:

• Power will be lost to the entire system.

• All valves will shut immediately and not in sequence.

NOTICE

To power down the system, always follow the controlled shutdown
procedure described in Section 5.4 Procedures after usage, on page
114.

Power failure
The system power is lost if any of the following applies:

• The MAIN SWITCH on the electrical cabinet is turned off.

• The mains cable disconnected.

• The power supply is lost.

If the electrical power to the system is lost, the following happens:

• All pumps stop.

• All valves will immediately revert to default positions.

When power returns to normal, the system will be in End state (i.e., it will not resume
the run).

2 Safety instructions
2.3 Emergency procedures
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Restart after emergency shut down
or power failure

Follow the instruction below to restart UniFlux 10 system after emergency shut down
or power failure.

Step Action

1 Make sure that the condition that caused the power failure or emergency
stop is corrected.

2

Reset the EMERGENCY STOP button by twisting it clockwise.

3 Press the Continue button in UNICORN.

Note: Forcing UNICORN or the Microsoft® Windows® operating system to close
during upload of data from the CU-960 will cause the unsaved data to be
lost.

NOTICE

If UniFlux 10 system fails to restart correctly following an emer-
gency shutdown or power failure, contact Cytiva for further advice
and assistance.

Data recovery upon restart
The UNICORN interface control unit, CU-960 (located inside the electrical cabinet),
has capabilities to store real time data during short disconnection from the computer.
Data stored on the CU-960 can be uploaded to the computer once communication to
the computer is re-established. Upload of data from the CU-960 to the computer will
be indicated on the monitor. The system can be controlled again once the upload of
data from the CU-960 is completed. Data upload can take several minutes to
complete. For more information about uploading data from the CU-960, refer to the
UNICORN manual package.

2 Safety instructions
2.3 Emergency procedures
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3 System description

About this chapter
This chapter provides descriptions of UniFlux 10 system and an overview of all compo-
nents, including the UNICORN control system.

In this chapter

Section See page

3.1 Configurations 29

3.2 Illustrations 30

3.3 Standard components 35

3.4 Optional components 47

3.5 Filter cassette configuration 54

3.6 Hollow fiber (HF) configuration 59

3.7 Meters and sensors 63

3.8 Flowchart 70

3.9 UNICORN control system 74

3 System description
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3.1 Configurations

Introduction
The UniFlux 10 series is a product range of cross flow filtration (CFF) systems that
utilizes UNICORN software for full automation with data logging capabilities over the
entire cross flow process.

The systems are configured to operate hollow fiber cartridges suited for microfiltration
applications such as cell clarification/harvesting, or cassettes/hollow fibers for ultrafil-
tration applications, such as protein concentration and diafiltration in downstream
unit operations.

UniFlux 10 system can be individually configured according to the specific process
requirements. This section summarizes the standard and optional components of
UniFlux 10, and indicates where further information on these components is to be
found.

Components
Standard UniFlux 10 components are described in Section 3.3 Standard components,
on page 35.

Optional UniFlux 10 components are described in Section 3.4 Optional components, on
page 47.

The UNICORN control system is described in Section 3.9 UNICORN control system, on
page 74. The product documentation package includes the Software Configuration
Description, which describes all functions of the control software in detail.

Material compliance
All plastic and polymer materials that come in contact with buffers and samples are
compliant with USP Class VI.

All materials used are traceable back to their production batches.

You can find information about the design and materials used in your system in the the
documentation package supplied with the system.

Chemical resistance is described in Section 8.4 Chemical resistance, on page 153.

Information about process wetted materials can be found in Process wetted materials,
on page 166.

3 System description
3.1 Configurations
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3.2 Illustrations

Introduction
This section provides illustrations of the UniFlux 10 system. The main features and
components are indicated.

Front view

Part Function

1 Permeate line equipment mounting beam

2 Tank and peristaltic pumps mounting beam

3 Filter cassette, cassette configuration shown

3 System description
3.2 Illustrations
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Part Function

4 EMERGENCY STOP button

5 PAUSE button

6 RUN/PAUSE indicator light

7 POWER indicator light

8 MAIN SWITCH, power

9 ALARM indicator light

10 CONTINUE button

11 Caster without brake (2 pcs)

12 Caster with brake (2 pcs)

3 System description
3.2 Illustrations
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Rear view

10

11

12

Part Function

10 Electrical cabinet door locks (2 pcs)

11 Filter and fan for cabinet cooling

12 External device connectors, refer to External connectors, on page 33

3 System description
3.2 Illustrations
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External connectors
The illustrations below show the external connectors on the UniFlux 10 system.

Part Function

M-241 Mixer motor control

AIT-131 UV-connector

EXTERNAL
SIGNALS

Connector for user process site signal communications

PROFIBUS PROFIBUS™ connector

AIR INLET System air inlet

UNICORN
ETHERNET

UNICORN Ethernet connector

AIR EXHAUST System air exhaust

ZSO-064 Hollow fiber drain valve control signal connector

ZSO-081 Quadruple valve option control signal connector

ZSO-082 Quadruple valve option control signal connector

ZSO-083 Quadruple valve option control signal connector

ZSO-084 Quadruple valve option control signal connector

3 System description
3.2 Illustrations
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Connectors in front recess

Part Function

P-202 Transfer pump control

P-203 Permeate pump control

AIT-131 UV-signal

Connectors on rear side

3 System description
3.2 Illustrations
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3.3 Standard components

About this section
This section provides an overview of the standard components of UniFlux 10 system.

In this section

Section See page

3.3.1 Structural components 36

3.3.2 Control system components 38

3.3.3 Connections and drains 39

3.3.4 Feed pump and feed line 41

3.3.5 Retentate line 42

3.3.6 Permeate line 43

3.3.7 Air integrity test device 45

3.3.8 Feed tank 46

3 System description
3.3 Standard components
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3.3.1 Structural components

Skid

The rigid stainless steel structure supports and protects all process components and
the electrical cabinet. The structure is designed for handling in a production environ-
ment and is easy to move and keep clean.

The structure occupies a small box-shaped space that makes it easy to fit into any loca-
tion in the production facility.

3 System description
3.3 Standard components

3.3.1 Structural components
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Electrical cabinet
The electrical cabinet contains all electrical and pneumatic equipment. When the door
is closed, the entire cabinet is ingress protected according to IP55.

3 System description
3.3 Standard components

3.3.1 Structural components
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3.3.2 Control system components

Introduction
This section describes the components that allow automation of the UniFlux 10 system
by the UNICORN control system.

Control system
The UniFlux 10 system is fully automated by means of the UNICORN control system.
Once the required methods are created and approved, a non-expert user can safely
operate the system.

Refer to Section 3.9 UNICORN control system, on page 74 for information on the
UNICORN control system.

Communications
Communication with most controlled components mounted outside the electrical
cabinet uses the PROFIBUS industry standard communication protocol and hardware.

3 System description
3.3 Standard components

3.3.2 Control system components
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3.3.3 Connections and drains

Illustration

P3

P1

P6

P7

P5

B1

P4

P2

Part Label on system Function

B1 FEED Feed inlet to system

P1 RETENTATE Retentate outlet

P2 PERMEATE Permeate outlet

P3 PERMEATE RECYCLE Permeate recycle to feed tank

P4 FEED DRAIN Feed drain point and product outlet

P5 CIP Clean-In-Place agent outlet

P6 RETENTATE DRAIN Retentate line drain point

P7 PERMEATE DRAIN Permeate line drain point

3 System description
3.3 Standard components

3.3.3 Connections and drains
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Description
The basic configuration of the UniFlux 10 system is provided with the following process
connections:

• Feed inlet

• Filter inlet, filter outlet and drain connections

• Retentate outlet

• Permeate outlet

• Permeate recycle outlet

• Pump outlet located before filters and meters. Can be used to supply feed tank CIP.

On the UniFlux 10 system, the feed inlet, retentate outlet and permeate recycle outlets
are connected to the integrated feed tank.

For a detailed description of interface points between the UniFlux System and the
customer plant process equipment, refer to Section 3.8 Flowchart, on page 70 and 
Section 8.3 Battery limits, on page 151.

3 System description
3.3 Standard components

3.3.3 Connections and drains
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3.3.4 Feed pump and feed line

Illustration

FEED OUT

PT-112

XV-001

FT-142

XV-061

PT-111

FEED IN

P-201

Description
The main purposes of the feed line are to transfer product (or feed) from the recircula-
tion tank, to the filter (FILTER) and to raise the pressure of the feed so that correct trans
membrane pressure (TMP), filter pressure and feed flow is achieved. This is done by the
feed pump, P-201.

To protect the system against over pressure, two pressure sensors, PT-111 and
PT-112 are provided for redundancy. If one should fail, an alarm will be triggered in
UNICORN but the remaining functional pressure sensor will still make sure that the
system is not subject to over pressure.

The feed line can be shut off with the XV-001 valve and drained through the XV-061
valve.

The internal diameter of the feed line is selected to keep the flow velocity of the
product within a favourable range with regard to the flow range for the each system.

3 System description
3.3 Standard components

3.3.4 Feed pump and feed line
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3.3.5 Retentate line

Illustration

FA-231

XV-051

PT-113

FILTER

TE-161XV-063PCV-341

TANK

XV-052

Description
Particles / molecules that are too large to pass through the filter pores are retained
through the filter as retentate.

Retentate is exhausted from the filter (FILTER) through the retentate connection and
then guided to the retentate outlet.

Sensors for pressure, PT-113, and temperature, TE-161 are located on the retentate
outlet line.

TMP is controlled by the pressure control valve PCV-341 regulated by UNICORN.

The entire retentate line can be shut off by closing the retentate valve XV-051.

The retentate line is drained through the drain valve XV-052.

3 System description
3.3 Standard components

3.3.5 Retentate line
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3.3.6 Permeate line

Illustration

AE-121

CE-101

XV-063

XV-031

XV-032

TANK

FILTER

FT-142

AE-131

PT-114

Description
Particles / molecules that are small enough to pass through the filter pores are
collected as permeate.

Permeate is exhausted from the filter through the permeate connection (FILTER) and
guided to the permeate outlet through XV-031 or back to the recirculation tank
(TANK) through XV-032.

Sensors for pressure (PT-114) and flow (FT-142) are located on the permeate outlet
line. Optionally, sensors for UV (AE-131), conductivity (CE-101) and pH (AE-121) can
also be installed on the permeate line.

3 System description
3.3 Standard components

3.3.6 Permeate line
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TMP is controlled by means of the pressure control valve PCV-341 on the retentate
line and the permeate pump P-203 if installed (option).

Flow control
Permeate flow can be controlled by the optional permeate pump, see Permeate control
pump P-203, on page 48.

Recycling
The permeate recycle line allows permeate to be routed back to the feed tank, for
instance when the process is set up and calibrated or during CIP.

3 System description
3.3 Standard components

3.3.6 Permeate line
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3.3.7 Air integrity test device

Description
UniFlux 10 is provided with an air integrity test device.

The principle is to apply pressurized air or nitrogen to the filter feed inlet with the reten-
tate outlet closed. The air or nitrogen will then escape through the wetted filter to the
permeate outlet with a certain flowrate depending on the characteristics of the
installed filter.

Components
The air integrity test device includes the components XV-063, FA-231, CV-321,
FT-143, PS-342, PY-342 and XY-041.

See Section 3.8 Flowchart, on page 70 for more information regarding these compo-
nents.

Testing and evaluating the results
For detailed information about the air integrity test see Air integrity test, on page 105.

Characteristic flowrate
It is recommended to perform an air integrity test on each new filter to establish its
characteristic air or nitrogen flow.

3 System description
3.3 Standard components

3.3.7 Air integrity test device
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3.3.8 Feed tank

Illustration

Description
The UniFlux 10 system is provided with a built-in feed tank with 5 or 10 liter volume.

The feed tank is connected to the pump feed inlet, the retentate outlet and the
permeate recycle outlet by means of flexible hoses routed so that mass measuring
during processing is not affected.

The weight of the tank contents is measured with a built in balance (load cell).

The tank is provided with a jacket with connections that can be used for either cooling
or heating as required.

As an option, a motor driven mixer can be provided.

3 System description
3.3 Standard components

3.3.8 Feed tank
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3.4 Optional components

About this section
UniFlux 10 system can be ordered or upgraded with a range of optional components.
This section briefly describes the optional components.

In this section

Section See page

3.4.1 Peristaltic pumps 48

3.4.2 Multiple inlets 49

3.4.3 UV monitor 50

3.4.4 pH sensor 51

3.4.5 Conductivity sensor 52

3.4.6 Feed tank mixer 53

3 System description
3.4 Optional components
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3.4.1 Peristaltic pumps

Illustration

Transfer pump P-202
The transfer pump P-202 (option) supplies material to the feed tank for a hooked up
UniFlux 10 system.

As material is separated out from the feed as permeate, the transfer pump can keep
the feed tank level within set limits.

If a feed tank is not provided by Cytiva, a signal from the customer plant installations
can be used to control the transfer pump through UNICORN. Refer to the SW-docu-
mentation provided with the system or contact your Cytiva representative for more
information.

Permeate control pump P-203
The permeate pump P-203 (option) controls the permeate flow rate.

3 System description
3.4 Optional components

3.4.1 Peristaltic pumps
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3.4.2 Multiple inlets

Illustration

Description
The feed inlet (option) is an upgrade to a multiple inlets blocks with four valves.

Typically, the inlets can be connected to product, buffer, water and CIP.

3 System description
3.4 Optional components

3.4.2 Multiple inlets
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3.4.3 UV monitor

Illustration

Description
The UV monitor (optional) is installed on the permeate line and is used to detect
protein leakage through the filter.

The UV light and detector operates at 280 nm.

Since UV measuring employs optics, it must be understood that the optical system
must be kept clean and undamaged to provide reliable readings.

3 System description
3.4 Optional components

3.4.3 UV monitor
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3.4.4 pH sensor

Illustration

Description
The pH sensor AE-121 (option) is installed on the permeate line and is used to measure
the pH of the permeate.

3 System description
3.4 Optional components

3.4.4 pH sensor
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3.4.5 Conductivity sensor

Illustration

Description
The conductivity sensor CE-101 (option) is installed on the permeate line and is used
to measure the conductivity of the permeate.

3 System description
3.4 Optional components

3.4.5 Conductivity sensor
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3.4.6 Feed tank mixer

Illustration

Description
The mixer option allows the feed to be stirred during processing. The mixer motor is
completely controlled by UNICORN.

3 System description
3.4 Optional components

3.4.6 Feed tank mixer
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3.5 Filter cassette configuration

Overview
When the UniFlux 10 system is operated with filter cassettes, the cassette holder and
required components of the piping system must be installed. The retentate line must
be located in the lower position.

In this section

Section See page

3.5.1 Filter cassette components 55

3.5.2 Cassette holder 56

3.5.3 Filter cassettes 58

3 System description
3.5 Filter cassette configuration
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3.5.1 Filter cassette components

Illustration

3 System description
3.5 Filter cassette configuration

3.5.1 Filter cassette components
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3.5.2 Cassette holder

Description
The cassette holder provides a convenient way to install and use the filter cassettes for
a filtering run.

The cassette holder follows industry standard cassette dimensions and accepts other
cassettes of standard layout.

When pressure is applied, the package of installed cassettes forms a single filtering
block.

From 1 to 5 filter cassettes can be installed in the cassette holder. The cassette holder
is manually adjusted.

See Section 5.1.4 Install filter cassettes, on page 104 for more information on how to set
up the cassette holders for a filter run.

More information regarding the cassette holders is also available in the UniFlux 10
system Data File with article no 18117765.

Illustration

1

2

3

4

5

6

7

8

9

10

11

Part Function

1 Stationary filter distributor plate

2 Permeate outlet

3 System description
3.5 Filter cassette configuration

3.5.2 Cassette holder
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Part Function

3 Feed inlet

4 Retentate outlet

5 Movable back plate

6 Filter retaining nut (2)

7 Filter retaining threaded rod (2)

8, 9 Filter retaining spacers (4)

10 Spillage plate drain outlet

11 Spillage plate

3 System description
3.5 Filter cassette configuration

3.5.2 Cassette holder
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3.5.3 Filter cassettes

Illustration of membrane filter
cassettes

Description
Membrane filter cassettes consist of many layers of membranes, separated with a
mesh. The size of the pores determines the filtering characteristics of the cassette,
that is, the cut-off size for particles that either will be retained or filtered out with the
permeate.

Every second membrane gap houses either the feed-retentate flow or the permeate
that passes through the membrane.

The substances in the gaps between the membranes are collected through the holes in
the edge of each cassette. The large holes are connected to the feed and retentate
compartments and the small holes will collect the permeate.

When more than one cassette is used for a filtering run, the holes of the cassettes align
with each other to form common sealed channels.

Available types of cassettes
Refer to your Cytiva representative for information regarding different cassettes that
can be used with the UniFlux 10 filtration system.

3 System description
3.5 Filter cassette configuration

3.5.3 Filter cassettes
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3.6 Hollow fiber (HF) configuration

Overview
When a UniFlux 10 system is operated with hollow fiber cartridges, required compo-
nents of the piping system must be installed.

In this section

Section See page

3.6.1 UniFlux 10 HF configuration 60

3.6.2 HF cartridges 61

3 System description
3.6 Hollow fiber (HF) configuration
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3.6.1 UniFlux 10 HF configuration

Illustration

Part Function

1 Retentate hose

2 Permeate hose

3 Hollow fiber cartridge, size 5 or 6 is accepted.

4 HF cartridge drain valve (XV-064)

5 HF cartridge drain hose

3 System description
3.6 Hollow fiber (HF) configuration

3.6.1  UniFlux 10 HF configuration
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3.6.2 HF cartridges

Illustration of HF cartridge

Description of HF cartridges
Hollow fiber (HF) cartridges contain numerous very thin hollow fibers glued together in
the ends. Each fiber is open in the ends and the feed flows inside the fibers and out the
other end.

The size of the pores determines the filtering characteristics of the cartridge, that is,
the cut-off size for particles that either will be retained or filtered out with the
permeate.

The permeate flows outside the fibers and is collected through one of the side connec-
tors.

Available types of HF cartridges
UniFlux 10 system is designed to accept Hollow fiber cartridges of different sizes.
These cartridges are described in the Hollow fiber cartridges for membrane
separations Operating Handbook, Cytiva article no 18116530. and in the Hollow fiber
cartridges and systems for membrane separations Selection Handbook, Cytiva article
no. 18116529.

For available hollow fiber cartridge models and sizes, see Section 8.1 Specifications, on
page 146.

3 System description
3.6 Hollow fiber (HF) configuration

3.6.2 HF cartridges
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HF cartridge draining

 

Hollow fibre cartridges are provided with two connections to the permeate compart-
ment, one in each end.

When mounted vertically, which is the case for all UniFlux 10 systems, the bottom
connection serves as drain for the permeate. This allows for more complete recovery of
the permeate.

3 System description
3.6 Hollow fiber (HF) configuration

3.6.2 HF cartridges
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3.7 Meters and sensors

About this section
This section describes the meters and sensors that are available as basic configuration
and optional components for UniFlux 10 system.

In this section

Section See page

3.7.1 Pressure 64

3.7.2 Flow 65

3.7.3 pH, conductivity and UV 66

3.7.4 Temperature 67

3.7.5 Tank mass balance 68

3.7.6 More information 69

3 System description
3.7 Meters and sensors
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3.7.1 Pressure

Pressure sensors

PT-113

PT-114
PT-112

PT-111

Description
Four pressure sensors are provided. The pressure sensors PT-111 and PT-112 provide
pressure data for the feed pump outlet and filter feed inlet pressure, PT-113 measures
retentate pressure and PT-114 measures permeate pressure.

The pressure drop (delta P) is calculated in UNICORN by subtracting the retentate
pressure from the feed pressure.

The transmembrane pressure (TMP) is calculated in UNICORN by subtracting the
permeate pressure from the average of the feed and retentate pressure.

The pump outlet pressure sensors also provide feed pump and system over pressure
protection.

More information on the pressure sensors is provided in the system documentation
package.

3 System description
3.7 Meters and sensors

3.7.1 Pressure
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3.7.2 Flow

Flow sensors

FT-142

FT-141

Description
FT-141 measures the feed flow and FT-142 measures the permeate flow.

The retentate flow is calculated by UNICORN by subtracting the permeate flow from
the feed flow.

3 System description
3.7 Meters and sensors

3.7.2 Flow
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3.7.3 pH, conductivity and UV

pH, Cond and UV

AE-121

CE-101

AE-131

Description
The optional pH sensor AE-121 measures permeate pH. Calibration prior to each
filtration run is recommended. pH calibration is described in Section 6.5 pH calibration,
on page 129.

The optional conductivity sensor CE-101 measures permeate conductivity. Calibra-
tion at regular intervals is recommended.

The optional UV sensor AE-131 measures the UV absorption in the permeate line.

3 System description
3.7 Meters and sensors

3.7.3 pH, conductivity and UV
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3.7.4 Temperature

Temperature

TE-161

Description
Temperature is measured in the retentate line with the sensor TE-161.

3 System description
3.7 Meters and sensors

3.7.4 Temperature
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3.7.5 Tank mass balance

Illustration

Description
The UniFlux 10 system has a built-in feed tank that is provided with a balance for mass
measuring.

Prior to each filter run the balance should reset to zero to ensure reliable output. The
balance should be calibrated each time the system is moved or its balance is disturbed.
Calibration of the balance is described in Section 5.2.1 Preparing mass measuring, on
page 109.

Note: It is important that the balance is not loaded with any objects or disturbed in
any similar way during the calibration procedure and filter run.

NOTICE

If the UniFlux 10 system is moved with load cells unlocked, the tank
must be empty and only small gentle movements are allowed.

If the tank shall be transported or put into storage, the load cells
should always be locked.

3 System description
3.7 Meters and sensors

3.7.5 Tank mass balance
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3.7.6 More information

Sensor signals
Sensor signals are described in detail in Section 8.2 Signals, on page 150.

Location and tagging of sensors
Location and tagging of each sensor is described in Section 3.8 Flowchart, on page 70.

3 System description
3.7 Meters and sensors

3.7.6 More information
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3.8 Flowchart

UniFlux 10: Flow diagram
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Component description

Tag / System Function Note More information

AE-121 Permeate pH sensor Option Section 3.7.3 pH, conduc-
tivity and UV, on page 66

AE-131 Permeate UV monitor Option

B1 Tank feed inlet Section 3.3.8 Feed tank, on
page 46

B2, B3, B4 Quadruple inlets 1, 2 and 3 Part of quadruple
inlet option

Section 3.4.2 Multiple inlets,
on page 49

B5 Quadruple inlet 4

CE-101 Permeate conductivity
sensor with an integrated
temperature sensor
(TE-101)

Option Section 3.7.3 pH, conduc-
tivity and UV, on page 66

CV-321 Filter integrity test check
valve

Section 3.3.7 Air integrity
test device, on page 45

FA-231 Filter integrity test sanitary
filter

FA-232 Tank vent sanitary filter Section 3.3.8 Feed tank, on
page 46

FILTER Cross flow filter. Can be
either hollow fibre (HF)
cartridge or filter cassette.

Not included in
system, provided
by customer or
sold separately.

Section 3.5 Filter cassette
configuration, on page 54

FT-141 Feed flow meter Section 3.7.2 Flow, on page
65

FT-142 Permeate flow meter Section 3.7.2 Flow, on page
65

FT-143 Filter integrity test flow
meter

Section 3.3.7 Air integrity
test device, on page 45

M-241 Feed tank agitator motor Option Section 3.3.8 Feed tank, on
page 46

ME1 Tank vent

ME2 Tank jacket connection Section 3.3.8 Feed tank, on
page 46

ME3 Tank jacket connection Section 3.3.8 Feed tank, on
page 46

P1 Permeate outlet Section 3.3.6 Permeate line,
on page 43
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Tag / System Function Note More information

P2 Permeate pump outlet Part of permeate
pump option

Permeate control pump
P-203, on page 48

P3 Retentate drain Section 3.3.3 Connections
and drains, on page 39

P4 Feed drain / CIP outlet Section 3.3.3 Connections
and drains, on page 39

P5 Permeate drain

P6 HF filter cartridge drain HF configuration
only

Section 3.6 Hollow fiber (HF)
configuration, on page 59
and Section 3.3.3 Connec-
tions and drains, on page 39

P-201 Feed pump Section 3.3.4 Feed pump
and feed line, on page 41

P-202 Feed transfer pump Option Section 3.3.4 Feed pump
and feed line, on page 41

P-203 Transfer and permeate
pump

Option Permeate control pump
P-203, on page 48

PCV-341 Retentate pressure control Section 3.3.5 Retentate line,
on page 42

PS-342 Filter integrity test pressure
sensor

Section 3.3.7 Air integrity
test device, on page 45

PY-342 Filter integrity test pressure
regulator

PSE-371 Feed tank pressure relief
safety valve

Section 3.3.8 Feed tank, on
page 46

PT-111 Feed pump outlet pressure
meter

Section 3.7.1 Pressure, on
page 64

PT-112 Feed pump outlet pressure
meter

PT-113 Retentate pressure meter

PT-114 Permeate pressure meter

TANK Feed tank Section 3.3.8 Feed tank, on
page 46

T-342 Pressure regulator pulse
damper

Section 3.3.7 Air integrity
test device, on page 45
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Tag / System Function Note More information

TE-101 Permeate temperature
meter

Option. Included
in cond CE-101.

Section 3.7.4 Temperature,
on page 67

WE-176 Tank load cell Section 3.3.8 Feed tank, on
page 46

XV-001 Pump feed valve Section 3.3.4 Feed pump
and feed line, on page 41

XV-031 Permeate outlet valve Section 3.3.6 Permeate line,
on page 43

XV-032 Permeate recycle valve

XV-051 Retentate outlet valve Section 3.3.5 Retentate line,
on page 42

XV-052 Retentate drain valve

XV-061 Feed drain Section 3.3.3 Connections
and drains, on page 39

XV-062 Filter integrity test valve Section 3.3.7 Air integrity
test device, on page 45

XV-063 Permeate drain valve Section 3.3.3 Connections
and drains, on page 39

XV-064 HF filter cartridge drain
valve

HF configuration
only

Section 3.3.3 Connections
and drains, on page 39

XV-081, 082,
083, 084

Quadruple inlet 1, 2, 3 and 4
valves

Part of quadruple
inlet option

Section 3.4.2 Multiple inlets,
on page 49

XY-342 Filter integrity test valve Section 3.3.7 Air integrity
test device, on page 45
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3.9 UNICORN control system

Introduction
The UniFlux 10 system is controlled by UNICORN software.

UNICORN can save established processes as methods. Methods include the instruc-
tions necessary for process operation and documentation.

UNICORN includes a comprehensive system of user access levels to be set, limiting the
operations a given user may perform on UniFlux 10 system. To operate the system in a
safe way, you should limit access to the system to those qualified and trained in its
operation.

The UNICORN software wizards and the UNICORN manual package provide complete
instructions for programming and for using the software for process control.

System operators are responsible for designing methods which conform to standard
operating procedures and Good Manufacturing Practice procedures.

UNICORN is technically compatible with all relevant sections of FDA 21 CFR Part 11.

A part 11-system assessment checklist is available on request through the local Cytiva
representative.

Prerequisite knowledge
A working knowledge of UNICORN is required to operate the UniFlux 10 system safely.

Information on how to use UNICORN can be obtained from the UNICORN User Manuals
and available tutorials. This manual does not cover how to use UNICORN.

Contact your local Cytiva representative for advice if required.

System networks
UNICORN can be installed on a stand-alone computer to control one to four locally
connected systems. However, the computer can only show one system at a time.
Multiple computers can view the output data from one system. UNICORN can also be
installed on a network.
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Software modules
The UNICORN control software consists of four modules:

Module Function

UNICORN
Manager/
Administration
(UNICORN version
dependent)

File handling and administration tasks; for example, definition
of systems and managing user profiles.

Method Editor Method creation and editing for preprogrammed control of
UniFlux 10 system.

System Control Process online control and monitoring using pre-defined
methods or manual control.

Evaluation Evaluation and presentation of stored results.

Note: The modules are active when the program is operating and are not closed
when minimized. A minimized System Control unit may control a process.

Workflow

The workflow for using UNICORN for automatic system control includes these general
steps:

Step Action

1 Program a UniFlux 10 system method run using the UNICORN software. It is
possible to use an existing method or modify an existing method to meet
your run objectives.

2 Start the run using the method you created.

3 Monitor the run's progress using the System Control module. All the data
about your run is displayed in the System Control module. You have a
choice of four different panes that can be opened one at a time or all at once,
in separate parts of the window.

4 After completing the run, you can display the data in a detailed report using
extensive tools provided by the UNICORN Evaluation module.
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Cabinet controls and indicators

Note: The EMERGENCY STOP and MAIN SWITCH controls are not part of
UNICORN and are described in Section 2.3 Emergency procedures, on page
25.

Label Type Color Function

PAUSE Button Red Sets UNICORN in PAUSE mode
(is equal to the PAUSE button
in the UNICORN computer user
interface)

CONTINUE Button Black Sets UNICORN in RUN mode (is
equal to the CONTINUE
button in the UNICORN
computer user interface)

POWER Indicator Green Power is on:

Flashing: UNICORN starting up.

Steady: UNICORN ready.

RUN/PAUSE Indicator Yellow UNICORN method is active:

Flashing: UNICORN in state
pause.

Steady: UNICORN in state run.

ALARM Indicator Red System alarm:

Check UNICORN for detailed
information.
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Warnings
Warnings are generated to warn operating personnel that process parameters have
exceeded preset high and/or low limits, and that the process method continues.

Alarm signals
If equipment is connected that has lower limits than the system, the alarm levels must
be set accordingly.

If an analog or digital signal passes the predetermined alarm level, several things
happen at once:

• An audible alarm is sounded (according to user preference settings).

• The system is set to Pause mode.

• The valves and other components on the system are set to their default positions.

Note: If an alarm is displayed that is not explained in the Software documentation,
please contact your local Cytiva representative.

Alarm test
The alarm buzzer can be tested from the control system using the buzzer test function
Alarms →BuzzerTest.

To test a specific instrument alarm it is possible to lower the alarm limit for the instru-
ment below the current process value.

Alarm reset
The alarm is reset through the control system by acknowledging the alarm message.
The process can be started again using the Continue function in UNICORN, if the
situation has been rectified.

More information
All required manuals are available from the UNICORN user interface. Select Help
→Manuals from the UNICORN top menu. The UNICORN user reference manual for
BioProcess™ is especially suited for usage with BioProcess systems.

Information about how to create a method for the UniFlux 10 in the UNICORN Method
Editor is presented in the end of this Operating Instructions.
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4 Installation

About this chapter
This chapter provides required information to enable users and service personnel to
unpack, install, move and transport UniFlux 10 system.

In this chapter

Section See page

4.1 Site requirements 79

4.2 Transport 81

4.3 Unpacking 82

4.4 UniFlux 10 Setup 84

4.5 Power supply 91

Precautions

WARNING

Before attempting to perform any of the procedures described in
this chapter, you must read and understand all contents of the
corresponding section(s) in the Safety instructions chapter as
listed below:

• General precautions on page 12

• Personal protection on page 14

• Installing and moving on page 15

• Power supply, on page 18

4 Installation
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4.1 Site requirements

Space and floor load
For space and floor requirement, see external dimensions and weights in Section 8.1
Specifications, on page 146.

• Make sure that the floor can handle the UniFlux 10 system weight at fully loaded
conditions. Please observe that for the weight to be equally distributed over all
wheels, the floor must be level and without irregularities.

• In order to allow convenient working conditions for the operator, sufficient space
should be provided at all sides of the combined UniFlux System and UniFlux Tank
when installed at the intended production location.

Environmental requirements

• The UniFlux 10 system is intended for indoor use only.

• The room must have forced ventilation.

• Requirement regarding ambient air temperature is specified in the General Specifi-
cation included in the system documentation package.

The following conditions should be avoided.

• Sources of heat, such as direct sunlight

• Strong magnetic or electric fields

• Vibrations

• Corrosive gas

• Dust

• Temperatures outside recommended operating ranges. For ambient environment
temperature range, see Section 8.1 Specifications, on page 146.

Electrical power
See Section 4.5 Power supply, on page 91 and Section 8.1 Specifications, on page 146
for power, voltage and phase requirements.

Compressed air

• Dry and particle free air for system supply.

• See Section 8.1 Specifications, on page 146 regarding capacity requirements.

• See Section 4.4.4 Connect compressed air supply, on page 88 regarding connec-
tions to the instrument.

Media supply
Supply must be arranged so that piping dimensions, piping lengths, valves and height
differences do not obstruct processing.
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See Section 8.1 Specifications, on page 146 regarding requirements on media supply
and delivery.

Battery limits
The term "battery limits" represents all interface points between the UniFlux 10 and
the customer process plant.

System battery limits require connections, not included in the Cytiva delivery.

See Section 3.8 Flowchart, on page 70 and Section 8.3 Battery limits, on page 151 for
description of required connections.
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4.2 Transport

Introduction
This section outlines important information that must be considered when trans-
porting UniFlux 10 system.

Transport in crate
Use a pallet jack or forklift with a minimum capacity to match the empty weight of the
system plus the transport crate. See Section 8.1 Specifications, on page 146 regarding
system weight.

Note: Make sure that intended openings and apertures are large enough to allow
passage of the box when lifted from the floor for transport.

For minimum door aperture size, refer to Section 8.1 Specifications, on page 146.

Moving when unpacked

WARNING

Heavy object. Because of the significant weight of the product,
great care must be taken not to cause squeezing or crushing inju-
ries during movement. At least two, but preferably three or more,
people are recommended when moving the unit.

UniFlux 10 system can be rolled by hand on hard and level surfaces with wheel brakes
released.

If the floor quality does no allow rolling the system on its own wheels, it can be moved
with a pallet jack or forklift.

For minimum door aperture size, see Section 8.1 Specifications, on page 146.
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4.3 Unpacking

Precautions

WARNING

Heavy object. Because of the significant weight of the product,
great care must be taken not to cause squeezing or crushing inju-
ries during movement. At least two, but preferably three or more,
people are recommended when moving the unit.

WARNING

Move transport crates. Make sure that the lifting equipment has
the capacity to safely lift the crate weight. Make sure that the crate
is properly balanced so that it will not accidentally tip when moved.

CAUTION

To prevent bacterial growth, the product may be partly filled with
denatured alcohol (18% C2H5OH (ethanol), 2% C3H7OH (isopro-
panol) and 80% H2O (water)) at delivery.

The denatured alcohol mixture can be hazardous to humans
if consumed.

Flush out the denatured alcohol before assembling, testing or inte-
grating the product into the intended process context.

Tools required

• Suitable lifting device, fork lift or similar. See Section 8.1 Specifications, on page 146
for dimensions and weight to be handled.

• 13 mm wrench (or ratchet with 13 mm socket).

• Electrical screwdriver with no. 2 bit.

• Knife.

• Lever (enclosed in crate).

Note: Refer to the unpacking instructions for UniFlux Systems (art. no 29065657)
for detailed unpacking instructions.
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Visual inspection
Check the following:

• Check that all equipment is enclosed in the crate according to the packing list.

• Check that the equipment for any apparent damage and document carefully if
found.

If any equipment is missing or damage is found, contact your Cytiva representative
immediately.

General unpacking instructions

Note: Refer to the unpacking instructions attached to the outside of the crate
when unpacking the crate. In absence of the unpacking instructions, follow
the general unpacking instructions below.

Step Action

1 Remove the front, side and back panels by loosening the bolts.

2 Remove the ramp, accessories and documentation package.

3 Attach the ramp on the cabinet side of the crate.

4 Remove the brackets on the cabinet side.

5 Carefully roll the system out of the crate.

WARNING

Heavy object. The ramp included in the transport crate is not rein-
forced in the center. Do not use a pallet lifter or forklift on the ramp.

WARNING

Heavy object. When rolling the system down the ramp take great
care to avoid the wheels slipping off the edge of the ramp.
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4.4 UniFlux 10 Setup

Precautions

CAUTION

To prevent bacterial growth, the product may be partly filled with
denatured alcohol (18% C2H5OH (ethanol), 2% C3H7OH (isopro-
panol) and 80% H2O (water)) at delivery.

The denatured alcohol mixture can be hazardous to humans
if consumed.

Flush out the denatured alcohol before assembling, testing or inte-
grating the product into the intended process context.

In this section

Section See page

4.4.1 Lock the wheels 85

4.4.2 Stand-alone computer 86

4.4.3 Setup of control system and network 87

4.4.4 Connect compressed air supply 88

4.4.5 Filter setup, feed pump and CFF filter protection 90
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4.4.1 Lock the wheels

After positioning the system at its designated location, lock the wheels as illustrated
below.
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4.4.2 Stand-alone computer

Connect a stand-alone computer to
the UniFlux 10 system

Connect a stand-alone computer with UNICORN to UniFlux 10 by plugging in an
Ethernet cable to the UNICORN ETHERNET connector illustrated below.

Note: When installing a stand-alone computer ensure that it is installed with
appropriate precautions for the intended environment that might expose
the computer to liquids and moisture.
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4.4.3 Setup of control system and network

Introduction
This section describes the steps that need to be performed to set up the UNICORN
control system and network connections.

Install UNICORN
Make sure that the UniFlux 10 control software UNICORN is installed on your
computer. A system must be defined, and the UniFlux 10 configuration or strategy
must be installed. Refer to UNICORN Administration and Technical manual for more
information.

Set up Controller Unit 960 (CU-960)
The CU-960 is part of the UniFlux 10 system at the delivery. It is a control unit that
communicates with UNICORN via Ethernet connection.

To use the Ethernet connection, the CU-960 must be set up like a network device with
IP address, default gateway and subnet mask address.

Refer to the control unit manual for more information.
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4.4.4 Connect compressed air supply

Introduction
This section describes how to connect the compressed air supply.

For requirements on air supply, see Section 4.1 Site requirements, on page 79.

Connect compressed air supply to
UniFlux 10 10

Step Action

1 Connect compressed air to the AIR INLET on the electrical cabinet.

2

1

Part Function

1 Air exhaust

2 Air inlet
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Step Action

2 Make sure that the supply pressure to the cabinet is between 5.5 and 7 bar g.
The manometer is set to 6 bar g at the factory and shall not be changed.
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4.4.5 Filter setup, feed pump and CFF filter protection

Filter setup
If the system is configured for the intended filter type (HF or cassette), no need for
further installations are required at arrival to the process site or between processing.

If the system needs to be reconfigured from HF- to cassette setup or the other way
round, see Section 6.7 Change filter type, on page 133.

Feed pump and CFF filter protection
To protect the system from feed containing particles that may clogg the CFF-filter or
damage the pump, use upstream normal flow filtering as described in Section 5.1.1
Sample handling, on page 98.

NOTICE

Do not use an inline filter screen on the piping between the recircu-
lation tank and the feed pump. If such a filter screen becomes
clogged, the flow to the feed pump will be restricted and the pump
may be damaged because of cavitation.
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4.5 Power supply

Introduction
This section gives an overview of the power requirements for UniFlux 10 system. This
includes a description of the various circuit breakers.

Power requirements
The power supply requirements are specified in Section 8.1 Specifications, on page 146.

WARNING

Protective ground. The product must always be connected to a
grounded power outlet.

WARNING

National Codes and standards (NEC, VDE, BSI, IEC, UL etc.) and local
codes outline provisions for safely installing electrical equipment.
Installation must comply with specifications regarding wire types,
conductor sizes, plugs, branch circuit protection and disconnect
devices. Non-compliance may result in personal injury and/or
equipment damage.

Installation
Connect the system power cord to a fixed power supply by means of a permanent
connection which can be detached only by the use of a tool.

WARNING

All electrical installations must be performed by authorized
personnel only.

UPS power supply
Cytiva does not offer a UPS (Uninterrupted Power Supply) as an accessory. However,
the system is prepared for UPS operation.

For UPS operation, a UPS should be connected to the main power supply of UniFlux 10.

4 Installation
4.5 Power supply

UniFlux 10 Operating Instructions 28993587 AF 91



CAUTION

Connection of an external Uninterruptible Power Supply (UPS)
(uninterrupted power supply) for system operation shall only be
performed by authorized personnel to avoid mismatching or
connection errors. Contact your local Cytiva representative for
more information.

Grounding and protective earth

• The protective earth wire must be connected to system ground.

• Ground impedance must conform to the requirements of national and local indus-
trial safety regulations and/or electrical codes.

• If the leak current exceeds 10 mA, a high leakage current earth connection must be
provided and confirmed before connecting power supply.

See Electric power, on page 149 or the system documentation package for informa-
tion regarding the leakage current for your system.

• The integrity of all ground connections must be periodically checked.

Isolation switch
An isolation switch must be present in the fixed power supply.

Breaking the power supply to the UniFlux 10 system by using this isolation switch must
be equivalent to disconnecting the power cord for a non-fixed connected instrument.

Power supply cable
The mains power supply cable is shielded ÖLFLEX™ of type: 150CY Quattro (3G x
2.5 mm2, G = with PE conductor, X = without PE conductor)

If the cable needs to be replaced due to damage, the same type of cable or equivalent
must be used.

WARNING

Only personnel authorized by Cytiva may perform service, installa-
tion, and maintenance of components inside the cabinet.

Main power supply wire colors and
tags

The power cord wires are color coded as shown in the table below. They must be
connected to the corresponding terminals in the fixed power supply or to a connector
compatible with IEC 60309-2.
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Function EU

(CE
marking)

Terminal
label

Live (Phase) 1 (Black or
brown)

L

Neutral 2 (Black or
blue)

N

Protective
ground
(earth)

Yellow/green PE = GND

Protective earth wire cross section
area

All protective earth wiring must have a cross section area equal to or more than the
specification in this table:

Leak current PE conductor minimum area

> 10 mA 10 mm2 copper or 16 mm2 aluminium

≤ 10 mA Equal to or larger than the L and N-wire

Ground fault breaker
UniFlux 10 system is not equipped with a general Ground Fault Circuit Breaker and it is
not an option that is available from Cytiva.

However, if ground fault protection for the system is desired, check the following:

• A Ground Fault Circuit Interrupter may be installed.

• The system may be connected to an outlet that is protected by a permanently
installed Ground Fault Circuit Breaker.

The tripping current for such an interrupter must be higher than the leak current as
found in the test protocol in the system documentation kit.

Built-in circuit breakers
The mains power supply to the UniFlux 10 system and the pumps are equipped with
circuit breakers inside the electrical cabinet. Refer to the System Documentation for
the specific types used in your system.
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More information
Wiring diagrams for the system, voltage, power, fuse requirements and the tripping
current for the fixed power supply ground fault protector can be found in the system
documentation package.
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5 Operation

About this chapter
This chapter provides the information required to operate the UniFlux 10 system in a
safe way.

In this chapter

Section See page

5.1 Prepare the system 97

5.2 Calibrations 108

5.3 Perform a run 112

5.4 Procedures after usage 114

Precautions

WARNING

Before attempting to perform any of the procedures described in
this chapter, you must read and understand all contents of the
corresponding section(s) in the Safety instructions chapter as
listed below:

• General precautions on page 12

• Personal protection on page 14

• System operation on page 18

WARNING

Before operation, all process connections and the piping system
must be tested for leakage at maximum pressure for continued
protection against injury risks due to fluid jets, burst pipes or
potentially explosive atmosphere.

5 Operation

UniFlux 10 Operating Instructions 28993587 AF 95



NOTICE

Only use chemicals listed in the Chemical Resistance information.

The wetted parts of the product may be damaged by chemicals not
listed in the Chemical Resistance information. Contact your Cytiva
representative before using chemicals that are not listed.

See Section 8.4 Chemical resistance, on page 153 for more information.
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5.1 Prepare the system

About this section
This section describes the steps that should be performed to prepare UniFlux 10
system for a run.

In this section

Section See page

5.1.1 Sample handling 98

5.1.2 Start the system and software 101

5.1.3 Install hollow fiber cartridges 103

5.1.4 Install filter cassettes 104

5.1.5 Testing 105

Prerequisites
Before the UniFlux 10 system is taken into operation, make sure that all procedures in
the following chapter and section have been performed:

• Actions described in Chapter 4 Installation, on page 78

• Actions before operation as described in Section 6.1 User maintenance schedule, on
page 117.
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5.1.1 Sample handling

Reasons for Normal flow filtration
(NFF)

Action Description

NFF before CFF If it can be suspected that large particles may be present in the sample,
for instance because of settling during sample hold, a Normal Flow
Filter (NFF) can be used to prevent these particles from entering the
UniFlux 10 during operation.

NOTICE

Make sure that large particles are prevented from
entering the UniFlux 10 system during operation,
otherwise, the filters may become clogged and the
feed pump may malfunction.

NFF after CFF If there is a need to prevent residual particles, larger than the CFF cutoff
size, to be recovered from the completed run, a NFF can be used when
recovering the processed product from the system.

Recommendations

The table below describes the situations where the Cytiva range of ULTA™ NFF
capsules can be used.
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If... Then use the following NFF... Placement...

If large particles
are present in the
sample container

• ULTA Prime CG capsule Between the
sample container
and the system
feed inlet

If large particles
are present in the
product

• ULTA Prime CG 0.2 µm

• ULTA Pure HC 0.2 µm sterile grade

• ULTA Pure SG 0.2 µm sterile grade

Between the
recovery outlet
and the product
container

Illustration of sample handling

UNIFLUX
System

G

A B
ULTA NFF

C

H

I

ULTA NFF

UNIFLUX
Tank

D

E

F

Part Function

A Container for starting material

B Starting material feed to ULTA NFF filter

C Filtered material to UniFlux 10 feed inlet

D Feed from tank to system

E Retentate from system to tank

F Permeate out

G Recovered material from UniFlux 10 after completed CFF run

H ULTA NFF filtered recovered material
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Part Function

I Container for recovered material, preferably a ReadyCircuit™ bag (part of
the ReadyToProcess™ portfolio) or equal
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5.1.2 Start the system and software

Start UniFlux 10

Step Action

1 Make sure that the air supply to the system is turned on.

2 Turn on the UPS if used.

3 Make sure that the electrical cabinet doors are closed and locked.

4 Switch on power to UniFlux 10 system by turning the MAINS POWER switch
to the "I" position. See Section 3.2 Illustrations, on page 30 for location.

5 Make sure that UNICORN is started according to the instruction in Start
UNICORN, on page 101. Wait for connection.

Start UNICORN

See Section 3.9 UNICORN control system, on page 74 for more information regarding
the UNICORN control system, warnings and alarms.

Step Action

1 Switch on the computer.

2 Log on to Microsoft Windows.

3 Start UNICORN by double-clicking on the UNICORN icon on the Windows
desktop.

4 When the UNICORN Logon dialog appears, select a user from the Users list
and enter the password.

If you log on for the very first time, select default and enter the password
default.

Note:

For some UNICORN versions it is also possible to select the Use Windows
Authentication checkbox and enter a network ID in the user name field.

5 Click OK.

6 In the System Control module, select System →Connect.

7 In the dialog shown, select the appropriate system name and click OK. The
system name is specified during installation configuration.

5 Operation
5.1 Prepare the system

5.1.2 Start the system and software

UniFlux 10 Operating Instructions 28993587 AF 101



Step Action

8 When UNICORN is connected to the system, the Run button in the status
bar is enabled. The button initially has a green color indicating the system is
ready to run.

5 Operation
5.1 Prepare the system

5.1.2 Start the system and software
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5.1.3 Install hollow fiber cartridges

Follow the instruction below to install the HF cartridges.

Step Action

1 Make sure that the system is configured for using HF cartridges and of the
intended size, see Section 6.7 Change filter type, on page 133 if required.

2 Prepare the HF cartridge(s) according to the manufacturer's instructions.

3 Install the cartridge into the system, refer to illustrations in Section 3.6
Hollow fiber (HF) configuration, on page 59.

5 Operation
5.1 Prepare the system

5.1.3 Install hollow fiber cartridges
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5.1.4 Install filter cassettes

General preparation of the cassettes

The table below describes general preparations before installing the cassettes.

Step Action

1 If the filter cassettes to be used are new, it is strongly recommended to
perform an air integrity test to establish its characteristic air or nitrogen
flow. See Air integrity test, on page 105 for instructions.

2 Prepare and check the cassettes according to the manufacturer's instruc-
tions.

5 Operation
5.1 Prepare the system

5.1.4 Install filter cassettes

104  UniFlux 10 Operating Instructions 28993587 AF



5.1.5 Testing

Introduction
Before using your UniFlux 10 system and cassette to process product, do the following:

1. Perform a leakage test.

2. Perform an air integrity test.

Leakage test

Note: For allowed deviations from reference values during leakage testing, refer to 
Section 8.2 Signals, on page 150 or Functional Test Records, in the
documentation package.

Step Action

1 Pressurize the system up to the maximum intended process pressure.

2 Watch the system for leaks while maintaining this pressure. Pay special
attention to the filter installation.

If a leak-free seal is not achieved at this pressure, there may be a cassette,
gasket, or surface finish irregularity. Proceed as follows:

3 Remove the filters and inspect the sealing surfaces.

4 Correct any found problem, reinstall the filters and perform the test again.

Air integrity test

It is recommended to perform an air integrity test on each filter before usage.

All instructions below are performed in UNICORN.

Step Action

1 Prepare the system for the test:

a. Flush the system and filter with water or buffer.

b. Drain the system from all fluid.

c. Make sure that process grade air supply to the integrity test is connected
and turned on, refer to Section 4.4.4 Connect compressed air supply, on
page 88.

2 Isolate the upstream process by closing the following valves:

• Feed valve XV-001.

• Retentate pressure control valve PCV-341.

• Retentate valve XV-051.

5 Operation
5.1 Prepare the system

5.1.5 Testing
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Step Action

3 Open the Permeate valve XV-031 to Permeate.

4
NOTICE

Never let the test pressure exceed the maximum filter
pressure as stated by the filter manufacturer. If the filter
is subjected to pressures exceeding this value, unrecov-
erable damage may occur.

Apply air pressure to the filter:

a. Set the Integrity_Test_Pressure to the pressure specified by the filter
manufacturer.

b. Open the Integrity test valve XV-063.

Note:

If the pressure as indicated by PT-113 takes more than 15 minutes to build
up and stabilize, this indicates that there is a leak somewhere in the system.

Identify and seal all leakages before proceeding with the test.

5 When the specified test pressure has been reached:

a. Wait for a stable air flow reading from the flow meter FT-143.

b. Compare this value to the integrity air flow value specified by the filter
manufacturer.

6 Terminate the air integrity test:

a. Set Integrity_Test_Pressure to zero.

b. Close the integrity test valve XV-063.

c. Open the retentate valve XV-051.

d. Open the Retentate drain valve XV-052.

7 Open the retentate pressure valve PCV-341 in small increments to protect
the filter.

When the PT-113 pressure indicator reads zero, the system is depressur-
ized and the test procedure completed.

If the flow deviates from the characteristic flow during an air integrity test, the
following conclusions can be drawn:

5 Operation
5.1 Prepare the system

5.1.5 Testing
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If... Then...

The air/nitrogen flow is signifi-
cantly lower than the charac-
teristic flow.

The filter is clogged and needs to be cleaned.

The air/nitrogen flow is signifi-
cantly higher than the charac-
teristic flow.

The are pores in the membranes or fibers that
have become larger than the nominal pore size.

or

The fibers or membranes are broken.

The filter will allow larger particles than the
nominal cut-off size to pass to the permeate and
must hence not be used for processing any
more.

Unexpected flowrate

5 Operation
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5.2 Calibrations

About this section
This section describes how to establish and enter hold-up volume, prepare mass meas-
uring, control meter range and calibration.

In this section

Section See page

5.2.1 Preparing mass measuring 109

5.2.2 Establishing and entering holdup volume 110

5.2.3 Meter range and calibration 111

5 Operation
5.2 Calibrations
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5.2.1 Preparing mass measuring

Introduction
Before the mass measuring system can be used to reliably measure and indicate the
contents of the tank, make sure that all load cell locking screws are fully released.

The measuring scale must then be set with regard to zero point and slurry density if the
density differs significantly from 1.0.

See Calibration: Mass measuring, on page 131 for the calibration procedure.

5 Operation
5.2 Calibrations

5.2.1 Preparing mass measuring
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5.2.2 Establishing and entering holdup volume

Introduction
The holdup volume is necessary for correct VolTank data. This is critical for the
concentration factor and diafiltration factor calculations as these instructions latch
onto the VolTank value.

Working principle
This method empirically determines the total retentate recirculation hold-up volume
including retentate piping and filter.

When to use this procedure
If the holdup volume is not known since previous filtration runs with the same setup,
this procedure should be performed to establish the correct holdup volume before the
filtration run is started.

Instruction

Step Action

1 Remove all liquid from the recirculation loop.

2 Transfer a set volume into the tank with the TransferFeedPump set to
50%.

3 Recirculate the liquid for one minute.

4 Calculate the difference between the Tank Fill Volume and the VolTank
reading. The resulting difference is the holdup volume.

5 Enter the calculated holdup volume by performing the following steps:

a. In UNICORN System Control module, select System →Settings.

b. In the UniFlux 10 Instructions dialog, select Specials and
System_Volume.

c. In the Skid field, enter the correct holdup volume. Click OK.

5 Operation
5.2 Calibrations

5.2.2 Establishing and entering holdup volume
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5.2.3 Meter range and calibration

Conductivity range
Make sure that the conductivity meter is set to the correct range. See Conductivity
range, on page 131.

Conductivity calibration
If necessary, calibrate the conductivity meter. See Conductivity test, on page 132.

pH-calibration
Calibrate the pH sensor. See Section 6.5 pH calibration, on page 129.

5 Operation
5.2 Calibrations

5.2.3 Meter range and calibration
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5.3 Perform a run

Precautions

WARNING

During operation, all cabinet doors must be closed and locked.

NOTICE

Excessive temperatures may damage the equipment. Do not run
the system at higher temperatures than the specified maximum
operation temperature as stated on the system label.

Final checks before start

NOTICE

Make sure that the actions listed below are completed before
UniFlux 10 is started.

• Check that the pump is filled with correct lubricant oil before start, refer to the
pump supplier documentation found in the document package for details.

• Check that all inlets and outlets to the system are connected, closed or in the state
that they are supposed to be before the system is started.

- Inlets that are not in use shall be closed.

- Outlets that are not in use shall be fitted with tubing and directed to waste.

• Check the condition of all connections and gaskets.

• Check that no chemicals that may be harmful to the system will be used.

• Perform an alarm test according to Alarm test, on page 77.

Start a run

Step Action

1 In the UNICORN System Control module, select Run in the File menu.

5 Operation
5.3 Perform a run
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Step Action

2 Select the method to start. Click OK.

A Start Protocol is displayed, consisting of a number of dialog boxes. On the
Variables page, it is possible to fine-tune the method before proceeding.
Checking the Show details box will display more detailed information.

3 Check that the sample volume is correct.

4 Click Next or Back to navigate through the dialog panels, adding the infor-
mation required as well as your own comments.

5 Click the START button in the Result Name dialog box. This will initiate the
method run.

Note: The pump needs a completely open flow path to enable start.

Monitor the run
The progress of the run can be viewed in detail in the UNICORN System Control
module.

Up to four different panels can simultaneously display different aspects of the run. To
customize content and layout of a panel, right-click in it and select Properties... from
the menu displayed. By selecting Documentation →Run notes, it is possible to add
notes during a run. Entered notes will be included in the results.

More information regarding the monitoring possibilities that the UNICORN user inter-
face offers is available in the UNICORN manual package.

End the run, normal completion
If no unexpected events occur during the run, UNICORN enters END state at method
completion without need for user interaction.

Ending the run before the method has
finished

To end the run before the method has finished, click on the End button at the top of the
Control module window.

This will produce a confirmation dialog. Click OK in the dialog to end the run, or click
Cancel to keep running.

In the dialog, you can choose to save the (partial) results from the run so far. If the run is
part of a scouting run, you are also given the choice of ending this. (If you do not, the
next run will start automatically.)

5 Operation
5.3 Perform a run
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5.4 Procedures after usage

Clean the filters
The filters can be cleaned in place if the method is set within the specific ranges for
solutions, temperature and pressure. The filters should be cleaned as described in 
Clean the filters, on page 121.

UNICORN shutdown

Step Action

1 In UNICORN, select File →Quit or click the Close icon in the Manager/
Administration module.

2 Confirm that you want to quit and select to leave system locked or unlocked.

3 Shut down the computer from the Windows Start menu.

4 When the computer screen has switched off, turn off the system power
switch.

Note:

Since the system power will be shut down, the system cannot be operated
from another workstation before the system is powered up again, regardless
if it is locked or unlocked at shut down.

Preparing for storage
Prepare the system for storage as described in Section 6.3 Storage, on page 124 as
required.

5 Operation
5.4 Procedures after usage

114  UniFlux 10 Operating Instructions 28993587 AF



6 Maintenance

About this chapter
This chapter provides required information to enable users and service personnel to
clean, maintain, calibrate and store the UniFlux 10 system.

In this chapter

Section See page

6.1 User maintenance schedule 117

6.2 Cleaning 119

6.3 Storage 124

6.4 Disassembly and assembly 127

6.5 pH calibration 129

6.6 Repair and calibration 131

6.7 Change filter type 133

Precautions

WARNING

Before attempting to perform any of the procedures described in
this chapter, you must read and understand all contents of the
corresponding section(s) in the Safety instructions chapter as
listed below:

• General precautions on page 12

• Personal protection on page 14

• Power supply, on page 18

• Maintenance on page 20

6 Maintenance
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WARNING

For continued protection against injury risks due to fluid jets, burst
pipes or potentially explosive atmosphere, the user must test the
piping system for leakage at maximum operating pressure.

• Always perform a leakage test after assembly or maintenance.

• Always perform a leakage test before operation or CIP.

WARNING

Decontaminate before service. Before performing any service
work on the system, make sure that the system has been properly
decontaminated.

6 Maintenance
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6.1 User maintenance schedule

Introduction
The maintenance recommendations are different depending on how frequently you
use your system. Note that the recommendation may not apply to your specific use of
the system. The system owner is solely responsible for establishing applicable routines
for periodic maintenance.

Before each run or weekly
This section covers maintenance actions required for each run or weekly (depending
on which happens first).

Component Action

UV monitor Set auto-zero by using the function in UNICORN.

pH monitor Clean, calibrate and store the pH electrode adequately, see 
Section 6.5 pH calibration, on page 129.

Alarm buzzer Check the function Alarms →BuzzerTest.

Complete system Clean/sanitize the system according to the procedure
described in Section 6.2.2 Cleaning-in-place (CIP), on page
123.

Protective earth Make sure that the protective earth wiring is not discon-
nected or damaged.

Monthly maintenance
The table below lists maintenance actions that are required monthly.

Component Action

Pump Check for oil leakage. (If the pump leaks, contact your local
Cytiva representative).

Connections and
seals

Check for leakage. Replace seals if needed. Perform a leakage
test at maximum operating pressure.

Annually or as needed
This section covers maintenance actions required annually or as needed.

6 Maintenance
6.1 User maintenance schedule
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Component Action

Complete system A preventive maintenance test procedure on all instruments,
sensors, pumps and valves should be performed annually by
trained and certified personnel. Contact your local Cytiva
representative. Replace all gaskets, o-rings and valve
diaphragms.

Complete stain-
less steel system

Inspect stainless steel systems for rust. If needed, passivate
the steel by recirculating a solution of 5% phosphoric acid in
the system overnight at room temperature and then rinse
with purified water until the pH of the outlet liquid is neutral.

Pump Replace all wear and tear parts. Replace drive element lubri-
cant. Refer to the System Documentation for details.

UV monitor Replace the UV lamp when the intensity is low or when a lamp
failure is indicated in UNICORN.

pH sensor Replace the pH electrode if difficulties are experienced during
calibration.

Conductivity
monitor

Clean and calibrate the conductivity monitor.

6 Maintenance
6.1 User maintenance schedule
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6.2 Cleaning

About this section
This section describes procedures and recommendations for cleaning UniFlux 10
system. Procedures for cleaning both the exterior, and CIP (cleaning-in-place) proto-
cols for cleaning the flow path are described.

In this section

Section See page

6.2.1 Important considerations for cleaning 121

6.2.2 Cleaning-in-place (CIP) 123

Precautions

WARNING

Flammable liquids. This product is not approved to handle flam-
mable liquids.

WARNING

Hazardous substances and biological agents. When using
hazardous chemical and biological agents, take all suitable protec-
tive measures, such as wearing protective clothing, glasses and
gloves resistant to the substances used. Follow local and/or
national regulations for safe operation and maintenance of UniFlux
10 system.

WARNING

For continued protection against injury risks due to fluid jets, burst
pipes or potentially explosive atmosphere, the user must test the
piping system for leakage at maximum operating pressure.

• Always perform a leakage test after assembly or maintenance.

• Always perform a leakage test before operation or CIP.

6 Maintenance
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NOTICE

Replace the pH electrode with the pH-probe dummy before
performing CIP with strong acids or alkali.

NOTICE

The filter may not be compatible with the CIP solutions. If so,
remove the filter and store or dispose of it in accordance with the
recommendations of the manufacturer.

6 Maintenance
6.2 Cleaning
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6.2.1 Important considerations for cleaning

Cleaning frequency
A suitable frequency of routine cleaning is determined by the nature of the starting
material and the type of process. However, routine cleaning shall be performed at
intervals aimed at prevention rather than cleaning the system from growth or contam-
ination.

Cleaning before planned
maintenance/service

To ensure the protection and safety of service personnel, all equipment and work areas
must be clean and free of any hazardous contaminants before a Service Engineer
starts maintenance work.

Please complete the checklist in the On Site Service Health and Safety Declaration
Form or the Health and Safety Declaration Form for Product Return or Servicing,
depending on whether the instrument is going to be serviced on site or returned for
service, respectively.

Health and safety declaration forms
Health and safety declaration forms are available for copying or printing in the Refer-
ence information chapter of this manual, or on digital media supplied with the user
documentation.

Recommended cleaning agents
All components can be cleaned with the most commonly used agents, such as deter-
gents, Ethanol, weak acids, Sodium Hydroxide and salt solutions.

See Section 8.4 Chemical resistance, on page 153.

NOTICE

Avoid Sodium Chloride solutions below pH 4.0. Rinse UniFlux 10
thoroughly with water immediately after contact with salt solu-
tions, to lessen the risk of corrosion.

Clean the UV and conductivity cell
The UV cell and conductivity cells are cleaned by flushing the cells with 1 M sodium
hydroxide or 20% ethanol.

Clean the filters

• Cytiva Hollow fiber cartridges cleaning procedures are provided in the Hollow fiber
cartridges for membrane separations Operating Handbook, Cytiva article no
18116530..

6 Maintenance
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• Filter units shall be cleaned according to the instructions from the respective manu-
facturer.

Clean external surfaces
The UniFlux 10 system is designed to be operated in a clean environment and the
external surfaces should not normally accumulate any substantial amount of dust or
dirt.

Regularly, wipe the outside of the UniFlux 10 system with a clean cloth. Use a mild
cleaning agent such as water, followed by 70% Ethanol. Regular wiping and care of the
equipment will help keep the surfaces uncorroded.

It is not recommended to spray or splash liquids towards external surfaces.

Do not spray or splash liquids towards filters or the fan on the electrical cabinet.

6 Maintenance
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6.2.2 Cleaning-in-place (CIP)

CIP methods in UNICORN
It is recommended that specific CIP protocols are developed to standardize the CIP
procedure in a repeatable and reliable manner depending on the applied user applica-
tion.

A routine cleaning method can be set up in UNICORN for regular cleaning and sani-
tizing of the system and connected components.

Refer to UNICORN manual package for comprehensive instructions on how to create a
sanitizing / CIP method in UNICORN.

Extended cleaning performance
If the UniFlux 10 system has been heavily contaminated and the normal CIP procedure
is not sufficient, cleaning performance can be improved by the following actions:

• Extending the total CIP time period.

• Changing to an alternative CIPagent.

• Filling the UniFlux 10 system and attached components with cleaning agent to
redissolve contaminants for an extended time period before applying CIP.

Rinsing
After completed CIP, rinse the UniFlux 10 system interior and all cleaned components
thoroughly with water of desired quality, for example Water For Injection (WFI), to
remove all traces of the cleaning agent.

6 Maintenance
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6.3 Storage

Introduction
This section provides instructions for short-term and long-term storage of UniFlux 10
system.

Precautions

WARNING

Hazardous substances and biological agents. When using
hazardous chemical and biological agents, take all suitable protec-
tive measures, such as wearing protective clothing, glasses and
gloves resistant to the substances used. Follow local and/or
national regulations for safe operation and maintenance of UniFlux
10 system.

NOTICE

It is recommended to prepare UniFlux 10 system for storage by
filling with 0.01 M sodium hydroxide or denatured alcohol (18%
C2H5OH (ethanol), 2% C3H7OH (isopropanol) and 80% H2O (water)).
Drying the system using sterile nitrogen or air flow may cause
static discharge that can damage valve control mechanisms, espe-
cially on systems with polypropylene tubing.

If the system is dried, the valve bodies should be grounded before
nitrogen or air flow is applied. Contact your Cytiva representative
regarding purchase and installation of grounding kits.

NOTICE

Fit protective caps on all electrical and optical connectors when
not in use.

NOTICE

When the product is filled with a storage solution, the temperature
must be high enough to prevent freezing, and low enough to
prevent evaporation.

6 Maintenance
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Short-term storage

The table below describes the procedure for short-term storage. This procedure is
applicable for storage durations of up to one month.

Step Action

1 Perform cleaning as described in Section 6.2 Cleaning, on page 119.

2 If the system is configured for filter cassettes, release the pressure of the
hydraulic unit to approximately 50 bar.

3 Replace the pH electrode with the pH plug. The electrode should be stored in
a 1:1 mixture on 4.0 pH buffer and 1 M KNO3. Place the pH electrode in the
pH electrode holder with the end submerged in storage solution.

Note:

Do not store the pH electrode in water only.

4 Fill the UniFlux 10 system with 20% Ethanol up to approximately one quarter
of maximum operating volume to prevent microbial growth.

Make sure that the filter cassettes are at least partially wetted during the
storage.

5 Seal off the UniFlux 10 system to prevent contamination caused by the
surrounding environment.

6 Maintenance
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Long-term storage

The table below describes the procedure for long term storage. This procedure is appli-
cable for storage durations of longer than one month.

Step Action

1 Perform the actions described for short-term storage above, with the differ-
ence that the filter cassettes first shall be replaced with filter cassette
dummies.

2 Place the UniFlux 10 system in a dust free environment with well-controlled
climate.

The temperature should be in the range 4°C to 25°C and stable.

The air humidity and air temperature differences should be kept as low as
possible to prevent condensation and corrosion.

3 Remove TC connection rubber gaskets in good condition suitable for
processing and place them in dark and cold storage while UniFlux 10 is out of
operation. This prevents them from aging and drying out.

Use other sealings, not in processing condition, as replacement during the
storage period.

To prevent microbial growth, the storage solution shall be replaced regularly if the
UniFlux 10 is stored for long periods of time.

Filter storage
The reference below provides storage procedures for Hollow fiber filters.

• Cassettes storage instructions are provided by the filter cassette manufacturer.

• Cytiva Hollow fiber cartridges storage procedures are provided in the Hollow fiber
cartridges for membrane separations Operating Handbook, Cytiva article no
18116530..

6 Maintenance
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6.4 Disassembly and assembly

Introduction
This section covers all disassembly and assembly procedures that the end user is
allowed to perform without support from Cytiva.

Precautions

WARNING

Only authorized personnel may open the electrical cabinet doors.
There is hazardous voltage inside the electrical cabinet that can
cause human injury or death.

WARNING

The electrical cabinet doors may only be opened when the product
is taken out of operation and subject to LOCK OUT / TAG OUT
(LOTO) (lockout-tagout).

WARNING

LOCK OUT / TAG OUT (LOTO)! Before any maintenance or
decommissioning work is performed on the system, make sure
that:

• the system is empty and depressurized.

• the system is disconnected from process feed, electrical power
and pneumatic supply.

• the system is prevented from accidentally becoming re-ener-
gized during maintenance.

• the system is clearly tagged as taken out of operation.

• all process wetted areas are clean and decontaminated.

WARNING

For continued protection against injury risks due to fluid jets, burst
pipes or potentially explosive atmosphere, the user must test the
piping system for leakage at maximum operating pressure.

• Always perform a leakage test after assembly or maintenance.

• Always perform a leakage test before operation or CIP.

6 Maintenance
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User-allowed actions
The following components may be disassembled or assembled by the user:

• Components for filter configurations

NOTICE

In order to reconfigure the system from cassette usage from
hollow fiber (HF) to cassette usage, or the other way round, a
number of components must be removed and installed.

The procedures for doing this is described in Section 6.7 Change
filter type, on page 133.

While these operations can be performed by a properly skilled
user technician, Cytiva recommends that a Cytiva service engi-
neer is assigned for this work.

Contact your Cytiva representative for more information on
changing filter configurations if required.

• The pH probe, see Section 6.5 pH calibration, on page 129.

Other components
Other than described in this chapter, the UniFlux 10 is not designed to be disassembled
or assembled by the user.

If the need for further disassembly should arise, always contact your Cytiva represen-
tative for advice before attempting any actions not described by this document.

6 Maintenance
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6.5 pH calibration

Required equipment

• pH reference solution for low pH-measuring point, preferably pH 4.00.

• pH reference solution for high pH-measuring point, preferably pH 7.00.

• Clean cloth.

• Clean water in spray bottle.

Calibration procedure

The table below describes how to calibrate the pH probe.

Note: Always have one end of the grounding strip submerged in the buffer during
calibration.

Step Action

1 Prepare two cups with the buffers representing the actual required pH
range.

2 Place one of the cups in the cup holder. Locate the pH-probe in the holder
with the end submerged in the buffer.

Note:

Attach the cap to the pH flow cell when to prevent foreign objects to enter the
flow path.

3 Select System →Calibrate in UNICORN System Control module.

4 Enter the pH value for the first buffer in the Reference value 1 field, wait for
the value to stabilize, and click Read value 1.
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Step Action

5 Remove the pH-probe from the holder and rinse it with distilled water.

6 Remove the cup with the first buffer from the holder and replace it with the
cup with the second buffer.

7 Relocate the pH probe in the holder with the end submerged in the buffer.

8 Enter the pH value for the buffer in the Reference value 2 field, wait for the
value to stabilize, and click Read value 2.

9 Wait for response and, if the electrode passed, click Close. Otherwise, click
Close, refresh/change the pH electrode, and repeat the calibration proce-
dure.

10 Remove the cup from the holder.

11 Relocate the pH probe in the flow cell as shown in the right image above.

6 Maintenance
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6.6 Repair and calibration

Introduction
This section describes component checks, repair and calibration of other components
(beside the pH probe) that the user can perform without Cytiva support.

Procedures can also be found in the respective product manuals found in the product
documentation package.

Components not covered in this manual may not be calibrated or repaired by the user.
If any such components of UniFlux 10 system do not operate according to specifica-
tions, contact your Cytiva representative.

WARNING

Do not attempt to perform any actions not described in these
documents.

Always contact your Cytiva representative for advice if such a need
should arise.

Calibration: Mass measuring
If the process run involves using the tank with liquids with a density that differs signifi-
cantly from water (1 kg/l), the scale weight measuring must be adjusted so that the
scale will report correct volume data.

The density can be set in UNICORN, in the Recirc Instructions.

Air integrity test
This method can be used to check that the filter is not damaged and that it has been
fitted correctly.

See Air integrity test, on page 105.

Conductivity range
The table below describes the two different conductivity ranges and when they can be
used.

Range Usage

High Normal operation

High and Low CIP
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Conductivity test
For instructions on how to calibrate the conductivity probe, refer to the system
documentation.

Remaining components
For instructions on how to calibrate other components and sensors, refer to the
respective manufacturer's manual in the system documentation package.

Components not covered by any of the above described procedures may not be cali-
brated by the user.

If any non user-calibratable components on the UniFlux 10 system appear to operate
off specifications, contact your Cytiva representative for advice.
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6.7 Change filter type

Introduction
The UniFlux 10 filtration systems can be operated either with filter cassettes or with HF
cartridges. While systems in general, including the entire automation SW, supports
both configurations, some components must be exchanged to allow running the
systems with each filter type.

This chapter describes the procedures and components required to switch between
cassette and HF operation.

NOTICE

While system filter type reconfiguration can be performed by a
properly skilled user technician, Cytiva recommends that a Cytiva
service engineer is assigned for this work.

Contact your Cytiva representative for more information on
changing filter configurations if required.

Change from filter cassette to HF
cartridge

Step Action

1 Make sure that all components required for the HF setup as shown on the
illustration above are available, refer to Section 3.6.1 UniFlux 10 HF configu-
ration, on page 60.
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Step Action

2 Remove the following components:

• The cassette holder.

• All cassette holder fittings.

The system should look like this when all components are removed:
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Step Action

3 Install the HF-specific components as shown in the illustration:

4 Install a decommisioned or dummy HF cartridge and test the system for
operation and leakages.
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Change from HF cartridge to filter
cassette

Step Action

1 Make sure that all components required for the cassette setup are available,
refer to Illustration, on page 55.

2 Remove the following components:

• The HF cartridge.

• All connecting hoses with fittings.

• The XV-064 permeate drain valve.

The system shall look like this when all components are removed:
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Step Action

3 Install the cassette specific components as shown in the illustration:

4 Install a dummy or decommisioned filter cassette and test the system for
operation and leakages.
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7 Troubleshooting

About this chapter
This chapter provides required information to enable users and service personnel to
identify and correct problems that may occur when operating UniFlux 10 system.

If the suggested actions in this guide do not solve the problem, or if the problem is not
covered by this guide, contact your Cytiva representative for advice.

Precautions

WARNING

Before attempting to perform any of the procedures described in
this chapter, you must read and understand all contents of the
corresponding section(s) in the Safety instructions chapter as
listed below:

• General precautions on page 12

• Personal protection on page 14

• Power supply, on page 18

• Maintenance on page 20

System

Compo-
nent

Possible cause Corrective action

Computer No system found
when starting up
UNICORN.

• Make sure the system is switched on.

• Check communication cable and
connectors.

• Reboot PC: shut down Windows, switch
off the system power switch, wait at least
5 sec, restart system.
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Compo-
nent

Possible cause Corrective action

Computer No connection
between the system
and UNICORN.

1. Open a System Control module.

2. • Select the System →Connect menu
command.

or

• Click the Connect to system
toolbar icon.

Result: The System Connect dialog
box opens.

3. Select the system you want to connect.

4. Click OK.

Power Power failure during
a run.

Check circuit breaker, both in system and
for external supply, as applicable.

Compress
ed air

Compressed air
failure during a run.
The alarm "No air
supply to the
system" is displayed
and the system
enters Pause
mode.

Insufficient air pressure caused by, for
instance, malfunctioning air supply equip-
ment or a leaking air hose. a) Rectify the air
supply problem. b) Restart the run by
pressing the Continue button.

Valves Alarm "Valve
error" is displayed.

If the "Valve error" alarm is accompanied
by "No air supply to the system", the
alarm is caused by a compressed air failure
(see above).

Pump Pump not working. • Emergency button has been pressed.

• No inlet or outlet valve open. Check
method and valves.

• Incorrect method. Check by entering
Pump →ManFlow > 1%.

• If none of the above, contact Cytiva
service personnel.
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Compo-
nent

Possible cause Corrective action

Little or no flow. • Check that connected inlet is actually
used.

• Inlet containers are placed too low rela-
tive to the pump. Check inlet containers.

• No liquid is supplied to the pump. Check
inlet containers.

• Tubing from inlet container causes pres-
sure or flow loss. Reasons may be too
long tubing, too small internal diameter,
tube may have a narrow section or is
partly plugged.

• Malfunctioning valve at container
battery limit.

Too high outlet
pressure.

• Check that connected outlet is actually
used.

• Outlet containers are placed too high
relative to the pump.

• Tubing to outlet container causes pres-
sure or flow loss. Reasons may be too
long tubing, to small internal diameter,
tube may have a narrow section or is
partly plugged. Check also for non-func-
tioning valve(s).

• Malfunctioning valve at container
battery limit.

UV curve

Error symptom Possible cause Corrective action

Ghost peak. Dirt or residues in the
flow path from
previous runs.

Clean the system.

Noisy UV signal, signal
drift or instability.

Bad UV fiber connec-
tions.

Check the connections of the
UV cell optical fiber. Replace if
necessary.

Dirty UV cell. Clean the UV cell, see Section
6.2 Cleaning, on page 119.
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Pressure curve

Error symptom Possible cause Corrective action

Erratic flow, noisy
baseline signal, irreg-
ular pressure trace.

Gas bubbles passing
through or trapped in
the pump.

Check that there is sufficient
supply of liquid.

Check all connections for
leaks.

Blockage or partial
blockage of flow path.

Flush through to clear
blockage.
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Cross flow filtration
See Air integrity test, on page 105.

Component Problem Possible
cause

Corrective action

Filter prob-
lems

The flow is too high in the air
integrity test.

Clogged filter. Clean the filter.

The flow is too low in the air integ-
rity test.

The pores in
the membrane
or fibers have
become larger
than the
nominal size

Change the filter.

The fibers or
membranes
are broken.

Change the filter.

Hydraulic
unit

The pump does not operate. The unit is not
connected to
electrical
power.

Plug the unit into the power
supply.

The power
switch is in the
OFF position.

Turn the power switch to
the ON position.

The pump does not reach the
desired pressure.

The regulator
is set below
the desired
pressure.

Adjust the regulator so that
the desired pressure can be
reached.

Low oil level in
the reservoir.

Check visually the oil level
and add oil if the level is too
low.

The oil level should be
approximately 60% of the
reservoir's volume (3 L),
then the hydraulic cylinder
and the tubes and hoses
should be filled with oil.
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Peristaltic pump

Component Problem Possible
cause

Corrective action

Peristaltic
pump

Displayed error message:

"P202 not healthy"

or

"P203 not healthy".

The affected
peristaltic
pump is either
disconnected,
faulty set up or
not working.

1. Check all cables and
connectors from the
pump to the electrical
cabinet.

2. Run instruction:

P202_clear faults

or

P203_clear faults.

3. Contact your local
Cytiva representative.

Little or no flow. Broken or
damaged
hose.

1. Check the pump hose.

2. Contact your local
Cytiva representative.

Conductivity

Error symptom Possible cause Corrective action

Baseline drift or noisy
signal.

Leaking tube connec-
tions.

Tighten the clamps. If neces-
sary, replace the clamps.

Bad pump. See manufacturer's user
documentation.

Dirty conductivity cell. Clean the conductivity cell,
see Section 6.2 Cleaning, on
page 119.

Absolute conductivity
value is wrong.

Bad calibration. Calibrate the conductivity
cell, see manufacturer's user
documentation.

Calibration solution
not correctly prepared.

Recalibrate using a new cali-
bration solution.

Incorrect or unstable
reading.

Bad pump or valve
action.

Check the pump and the
valves.

Temperature compen-
sation not properly set.

Check the temperature
compensation, see manufac-
turer's user documentation.
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pH curve

Error symptom Possible cause Corrective action

No response to pH
changes.

The cable to the elec-
trode not properly
connected.

Check the cable connection.

The electrode
membrane might be
cracked.

Replace the electrode.

Small or slow response
to pH changes.

The electrode
membrane might be
contaminated.

Clean the electrode, refer to
the manufacturer's user
documentation.

pH reading appears to
be incorrect.

pH-sensor not properly
calibrated.

Calibrate the pH-sensor as
described in Section 6.5 pH
calibration, on page 129.
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8 Reference information

About this chapter
This chapter provides reference information that may become useful when installing,
operating, maintaining and troubleshooting UniFlux 10 system. It also contains
ordering information.

The UniFlux 10 system is a modular built instrument that can be configured in many
different ways. To understand the specific configuration that applies to your UniFlux 10
system, please refer to the system documentation supplied with the instrument.

In this chapter

Section See page

8.1 Specifications 146

8.2 Signals 150

8.3 Battery limits 151

8.4 Chemical resistance 153

8.5 Recycling information 155

8.6 Regulatory information 156

8.7 Further information 166

8.8 Health and Safety Declaration Form 167
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8.1 Specifications

Dimensions
Note: • All dimensions are presented in cm where nothing else is noted.

• Dimensions and weights are valid for standard systems.

• Dimensions may vary for individual units by +/- 1 cm.

• Weights may vary for individual units by +/- 10 kg.

76 

19
4

80

20
1

UniFlux 10

Cable lengths

Cable Length

Communication 10 m (max 80 m)

Power supply, system
and pump

5 m

External I/O 5 m
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Weights

Configuration Weight

Complete configuration 300 kg

Complete configuration including crate, acces-
sories and documentation kit

440 kg

Capacity

Property Value

Operating flow, feed pump / recircula-
tion flowrate

Min 1 L/min at 4 bar

Max 10 l/min

Feed transfer- and permeate control
pump option, flow at 2 bar outlet back-
pressure

Min 20 ml/min

Max 2300 ml/min

Feed tank 5 or 10 liter

Operating limits

Property Value

Feed pump pressure at 20%, max 4.14 bar g (60 psi g)

Transfer and
permeate pumps

Feed temperature Min 5°C

Max 40°C

Outlet back pressure, max 2 bar

Battery limits back pressure Min 0

Max 0.2 bar (3 psi)

Process temperature Min 2°C (36ºF)

Max 60°C (140ºF)

Environmental limits

Parameter Value

Altitude Max 2000 m
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Parameter Value

Relative Humidity Max 80% for temperatures up to 31°C, decreasing
linearly to 50% relative humidity at 40°C.

Ambient temperature Requirement regarding ambient temperature is
specified in the General Specification included in the
system documentation kit

Ingress protection IP 55

Compressed air

Property Value

Pressure 6 to 10 bar (87 to 145 psi)

Consumption 50 Nl/min

Type Particle-free and non-condensing

Hollow fiber specifications

Property Value

No of filter cartridges, type 1, Hollow fiber

Cartridge Size 5 or 6

Total filter area Min 1.3 ft2 / 0.12 m2

Max 5.2 ft2 / 0.48 m2

Membrane cassette specifications

Property Value

No of cassette holders, type 1, Kvick Lab

No of cassettes Min 1

Max 5

Total filter area Min 1.2 ft2 / 0.11 m2

Max 6 ft2 / 0.55 m2
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Sound levels

Property Value

Feed pump Max <80 dB

Typical value under normal running conditions1 59 dB

1 Measured at the feed flow rate 5 l/min and feed pressure 2 bar

Electric power

Property Value

Power supply System Type L-N-PE

Voltage 110/230 V AC
±10%

Frequency 50 to 60 Hz

Pump Type N/A

Voltage 400/480 V AC
±10%

Frequency 50 to 60 Hz

Fuse rating System 110 V AC 16 A SB

230 V AC 10 A SB

Pump N/A

Ground fault interrupter, minimum break current 300 mA

Leak current 3.5 mA

Transient overvoltages Overvoltage cate-
gory II

Pollution degree 2

System hold-up volume
System hold-up volume is the volume in the feed and retentate piping from the system
feed inlet (B1) to the system retentate outlet (P1).

The approximate hold-up volume for indicated sections of the system is 0.2 liter.
Values may vary between individual systems.
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8.2 Signals

Signal Signal / Tag
name

Measuring
unit

Set range Acceptance
range

Feed Weight WIT-176 g 0 to 30 000 0 to 25 000

Pressure PT-111,
PT-112

bar g 0 to 6 0.1 to 6

Flow FT-141 l/min 0 to 15 0.5 to 10

Retentate Pressure PT-113 bar g 0 to 6 0.1 to 6

Temperature TE-161 ºC 0 to 100 2 to 60

Permeate Pressure PT-114 bar g -1 to 5 0.1 to 5

UV AIT-131 AU -1 to 4 0 to 1

Flow FT-142 l/min 0 to 0.3 0.02 to 2.5

Conductivity UUC-382 mS/cm 0.005 to 300 Low scale:
0.01 to 100

High scale:
100 - 300

pH AT-121 pH 0 to 14 4 to 7 / 7 to 10

Air integrity Flow FT-143 ml/min 0 to 100 10 to 70
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8.3 Battery limits

About battery limits
Battery limits represent interface points between the UniFlux 10 system and the
customer plant process equipment.

Battery limits can be thought as the points where functional responsibility is handed
over from the plant to the UniFlux 10 system or vice versa.

Process
The indicated dimensions represent the tubing connection (TC) flange size and the
minimum inner diameter for used hoses required to match battery limit connections.

Battery limit Label Tag Dimension

Feed inlet FEED B1 1/2" TC25

Retentate outlet RETENTATE P1 N/A

Permeate outlet PERMEATE P2 3/8" TC25

Retentate drain RETENTATE DRAIN P3 1/2" TC25

Feed drain FEED DRAIN P4 1/2" TC25

Permeate drain PERMEATE DRAIN P5 9.5 mm TC25

HF cartridge drain CARTRIDGE DRAIN P6 1/2" TC25

Pneumatic

Battery limit Label Tag Size and connector type

Air inlet AIR INLET PN1 Quickfit, female, hose 10 x 1 mm

Air outlet AIR OUTLET PN2 Quickfit, female, hose 10 x 1 mm

Electrical

Battery limit Tag Size and connector type

Main power supply ELl Shielded cable 5 m 2.5 mm2 I 14
AWG ULI CE approved

Remote alarm output EL2 Terminal connection (switchinq
dry contact)
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Battery limit Tag Size and connector type

UPS power failure alarm input EL3 Terminal connection, normally
low

Optional I/O interface EL4 16-pole connector

Unicorn Ethernet port on system EL5 4-pole connector
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8.4 Chemical resistance

Introduction
The table below gives allowed exposure concentrations and times for various chemi-
cals that may be used in Cytiva BioProcess™ instruments in general. For information
regarding hollow fiber chemical resistance, please refer to Hollow fiber cartridges for
membrane separations Operating Handbook, Cytiva article no 18116530.

Some of the chemicals listed may not be applicable for your instrument.

List of chemicals allowed

Chemical Concentration Max. time / cycle Max. acc.
expos.

Usage

Acetic acid 25% 3 h 3000 h CIP

Acetone 10% 1 h Unlimited UV cell test

Citric acid pH 2 to 2.5 1 h at temp ≤ 60°C 1000 h CIP

Ethanol 20% 12 months Unlimited Storage

Ethanol / Acetic
acid

20% 3 h 3000 h CIP

Guanidine

hydrochloride

6 M 5 h 5000 h CIP

Hydrochloric
acid

0.1 M at pH=1 1 h 1000 h CIP

Phosphoric
acid

5% Overnight Unlimited For SS passiva-
tion

2-propanol 30% 1 h 1000 h CIP

Sodium
chloride

0 to 3 M 3 h 3000 h Purification,
CIP

Sodium
hydroxide

1 M at pH=14

0.5 M

0.01 M at pH=12

24 h at temp ≤ 40°C

3 h at temp ≤ 60°C

12 months

1000 days

3000 h

Unlimited

CIP

CIP

Storage

Sodium hypo-
chlorite

300 ppm 3 h at temp ≤ 60°C 3000 h CIP

Sodium

hydroxide

/Ethanol

1 M / 20% 3 h 3000 h CIP
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Chemical Concentration Max. time / cycle Max. acc.
expos.

Usage

Urea 8 M 5 h 5000 h Purification,
CIP

Cleaning

solutions

1% to 6% STERIS™
CIP 100™, 0.5%
Henkel P3™-11,
0.2% Micro, 0.2%
Terg-a-zyme™, 0.1%
Tween™ 80

3 h at temp ≤ 60°C 3000 h CIP
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8.5 Recycling information

Introduction
This section contains information about the decommissioning of the UniFlux 10
system.

Decontamination
UniFlux 10 system shall be decontaminated before decommissioning and all local
regulations shall be followed with regard to scrapping of the equipment.

Disposal, general instructions
When taking the UniFlux 10 system out of service, the different materials must be
separated and recycled according to national and local environmental regulations.

Recycling of hazardous substances
UniFlux 10 system contains hazardous substances. Detailed information is available
from your Cytiva representative.

Disposal of electrical components
Waste electrical and electronic equipment must not be disposed as unsorted munic-
ipal waste and must be collected separately. Please contact an authorized representa-
tive of the manufacturer for information concerning the decommissioning of equip-
ment.
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8.6 Regulatory information

Introduction
This section lists the regulations and standards that apply to the product.

In this section

Section See page

8.6.1 Contact information 157

8.6.2 European Union and European Economic Area 158

8.6.3 Eurasian Economic Union
Евразийский экономический союз

159

8.6.4 Regulations for North America 161

8.6.5 Regulatory statements 162

8.6.6 Declaration of Hazardous Substances (DoHS) 163

8.6.7 Other regulations and standards 165
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8.6.1 Contact information

Contact information for support
To find local contact information for support and sending troubleshooting reports, visit 
cytiva.com/contact.

Manufacturing information
The table below summarizes the required manufacturing information.

Requirement Information

Name and address of manufacturer Cytiva Sweden AB

Björkgatan 30

SE 751 84 Uppsala

Sweden

Telephone number of manufacturer + 46 771 400 600
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8.6.2 European Union and European Economic Area

Introduction
This section describes regulatory information for the European Union and European
Economic Area that applies to the equipment.

Conformity with EU Directives
See the EU Declaration of Conformity for the directives and regulations that apply for
the CE marking.

If not included with the product, a copy of the EU Declaration of Conformity is available
on request.

CE marking

The CE marking and the corresponding EU Declaration of Conformity is valid for the
instrument when it is:

• used according to the Operating Instructions or user manuals, and

• used in the same state as it was delivered, except for alterations described in the
Operating Instructions or user manuals.
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8.6.3 Eurasian Economic Union
Евразийский экономический союз

This section describes the information that applies to the product in the Eurasian
Economic Union (the Russian Federation, the Republic of Armenia, the Republic of
Belarus, the Republic of Kazakhstan, and the Kyrgyz Republic).

Introduction
This section provides information in accordance with the requirements of the Tech-
nical Regulations of the Customs Union and (or) the Eurasian Economic Union.

Введение
В данном разделе приведена информация согласно требованиям Технических
регламентов Таможенного союза и (или) Евразийского экономического союза.

Manufacturer and importer
information

The following table provides summary information about the manufacturer and
importer, in accordance with the requirements of the Technical Regulations of the
Customs Union and (or) the Eurasian Economic Union.

Requirement Information

Name, address and telephone
number of manufacturer

See Manufacturing information

Importer and/or company for
obtaining information about
importer

LLC Global Life Sciences Solutions Rus

Russian Federation, 123112

Presnenskaya nab., 10, fl. 12, pr. III, room 6

Telephone: + 7 495 739 6931

Fax nr: + 7 495 739 6932

E-mail: rucis@cytiva.com

Информация о производителе и
импортере

В следующей таблице приводится сводная информация о производителе и
импортере, согласно требованиям Технических регламентов Таможенного союза
и (или) Евразийского экономического союза.

Требование Информация

Наименование, адрес и номер
телефона производителя

См. Информацию об изготовлении
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Требование Информация

Импортер и/или лицо для
получения информации об
импортере

ООО "Глобал Лайф Сайэнсиз Солюшнз
Рус"

Российская Федерация, 123112

Пресненская наб., д. 10, эт. 12, пом. III,
ком. 6

Телефон: + 7 495 739 6931

Факс: + 7 495 739 6932

Адрес электронной почты: 
rucis@cytiva.com

Description of symbol on the system
label
Описание обозначения на этикетке
системы

This Eurasian compliance mark indicates that the product is
approved for use on the markets of the Member States of the
Customs Union of the Eurasian Economic Union

Данный знак о Евразийском соответствии указывает, что
изделие одобрено для использования на рынках
государств-членов Таможенного союза Евразийского
экономического союза
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8.6.4 Regulations for North America

Introduction
This section describes the information that applies to the product in the USA and
Canada.

FCC compliance
This device complies with part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) This device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may cause unde-
sired operation.

Note: The user is cautioned that any changes or modifications not expressly
approved by Cytiva could void the user’s authority to operate the equip-
ment.

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in
a commercial environment. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. Operation of this
equipment in a residential area is likely to cause harmful interference in which case the
user will be required to correct the interference at his own expense.
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8.6.5 Regulatory statements

Introduction
This section shows regulatory statements that apply to regional requirements.

EMC emission, CISPR 11: Group 1,
Class A statement

NOTICE

This equipment is not intended for use in residential environments
and may not provide adequate protection to radio reception in
such environments.

South Korea
Regulatory information to comply with the Korean technical regulations.

NOTICE

Class A equipment (equipment for business use).

This equipment has been evaluated for its suitability for use in a
business environment.

When used in a residential environment, there is a concern of radio
interference.

주의사항
A급 기기 (업무용 방송통신 기자재)

이 기기는 업무용환경에서 사용할 목적으로 적합성평가를 받
은 기기
로서 가정용 환경에서 사용하는 경우 전파간섭의 우려가 있습
니다.
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8.6.6 Declaration of Hazardous Substances (DoHS)
根据 SJ/T11364-2014《电子电气产品有害物质限制使用标识要求》特提供如下
有关污染控制方面的信息。
The following product pollution control information is provided according to SJ/
T11364-2014 Marking for Restriction of Hazardous Substances caused by electrical
and electronic products.

电子信息产品污染控制标志说明
Explanation of Pollution Control
Label

该标志表明本产品含有超过中国标准 GB/T 26572 《电子电气产品中限用物质的限量要
求 》中限量的有害物质。标志中的数字为本产品的环保使用期，表明本产品在正常使用
的条件下，有毒有害物质不会发生外泄或突变，用户使用本产品不会对环境造成严重污
染或对其人身、财产造成严重损害的期限。单位为年。
为保证所申明的环保使用期限，应按产品手册中所规定的环境条件和方法进行正常使
用，并严格遵守产品维修手册中规定的定期维修和保养要求。
产品中的消耗件和某些零部件可能有其单独的环保使用期限标志，并且其环保使用期限
有可能比整个产品本身的环保使用期限短。应到期按产品维修程序更换那些消耗件和零
部件，以保证所申明的整个产品的环保使用期限。
本产品在使用寿命结束时不可作为普通生活垃圾处理，应被单独收集妥善处理。
This symbol indicates the product contains hazardous materials in excess of the limits estab-
lished by the Chinese standard GB/T 26572 Requirements of concentration limits for certain
restricted substances in electrical and electronic products. The number in the symbol is the Envi-
ronment-friendly Use Period (EFUP), which indicates the period during which the hazardous
substances contained in electrical and electronic products will not leak or mutate under normal
operating conditions so that the use of such electrical and electronic products will not result in
any severe environmental pollution, any bodily injury or damage to any assets. The unit of the
period is “Year”.

In order to maintain the declared EFUP, the product shall be operated normally according to the
instructions and environmental conditions as defined in the product manual, and periodic main-
tenance schedules specified in Product Maintenance Procedures shall be followed strictly.

Consumables or certain parts may have their own label with an EFUP value less than the product.
Periodic replacement of those consumables or parts to maintain the declared EFUP shall be done
in accordance with the Product Maintenance Procedures.

This product must not be disposed of as unsorted municipal waste, and must be collected sepa-
rately and handled properly after decommissioning.
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有害物质的名称及含量
Name and Concentration of
Hazardous Substances

产品中有害物质的名称及含量
Table of Hazardous Substances’ Name and Concentration

部件名称
Compo-
nent name

有害物质
Hazardous substance

铅
(Pb)

汞
(Hg)

镉
(Cd)

六价铬
(Cr(VI))

多溴联苯
(PBB)

多溴二苯醚
(PBDE)

28993587 X 0 0 0 0 0

0: 表示该有害物质在该部件所有均质材料中的含量均在 GB/T 26572 规定的
限量要求以下。

X: 表示该有害物质至少在该部件的某一均质材料中的含量超出 GB/T 26572
规定的限量要求。

• 此表所列数据为发布时所能获得的最佳信息.

0: Indicates that this hazardous substance contained in all of the homogeneous
materials for this part is below the limit requirement in GB/T 26572.

X: Indicates that this hazardous substance contained in at least one of the
homogeneous materials used for this part is above the limit requirement in
GB/T 26572

• Data listed in the table represents best information available at the time of
publication.
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8.6.7 Other regulations and standards

Introduction
This section describes the standards that apply to the product.

Additional design considerations
For additional design considerations, such as ASME-BPE, GMP and cGMPs information
refer to the product-specific specification information provided in the documentation
package delivered with each equipment.
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8.7 Further information

Process wetted materials
For a complete list of wetted materials, refer to the Equipment List and the General
Specification in the product documentation package.

Spare parts and accessories
Additional information regarding spare parts and acccessories can be found in the
system documentation.

Your local Cytiva representative will also be able to suggest recommended spare parts
and accessories.

Remaining aspects
Regarding any of the below topics, please contact your local Cytiva representative for
advice.

• Training

• Service

• Method optimization

• Ordering information

• Other issues not covered by this manual

Contact information is found on the back cover of this manual.
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8.8 Health and Safety Declaration Form

On site service

 

 

On Site Service Health & 
Safety Declaration Form 

 
 

Service Ticket #: 
 

 

To make the mutual protection and safety of Cytiva service personnel and our customers, all equipment and work areas must be 
clean and free of any hazardous contaminants before a Service Engineer starts a repair. To avoid delays in the servicing of your 
equipment, complete this checklist and present it to the Service Engineer upon arrival. Equipment and/or work areas  
not sufficiently cleaned, accessible and safe for an engineer may lead to delays in servicing the equipment and could be subject to 
additional charges. 
 

 Yes  No 
Review the actions below and answer “Yes” or “No”.  
Provide explanation for any “No” answers in box below. 

 

 

 

 

 

 

Instrument has been cleaned of hazardous substances. 
Rinse tubing or piping, wipe down scanner surfaces, or otherwise make sure removal of any dangerous residue. 
Make sure the area around the instrument is clean. If radioactivity has been used, perform a wipe test or other 
suitable survey. 

 

 

 

 

Adequate space and clearance is provided to allow safe access for instrument service, repair or 
installation. In some cases this may require customer to move equipment from normal operating location 
prior to Cytiva arrival. 

 

 

 

 
Consumables, such as columns or gels, have been removed or isolated from the instrument and from 
any area that may impede access to the instrument . 

  All buffer / waste vessels are labeled.  
Excess containers have been removed from the area to provide access. 

Provide 
explanation 
for any “No” 
answers here: 

 

Equipment type / Product No:  Serial No:  

I hereby confirm that the equipment specified above has been cleaned to remove any hazardous substances and that the area 
has been made safe and accessible. 

Name:  Company or institution:    

Position or 
job title: 

 Date (YYYY/MM/DD):  

Signed: 
 

Cytiva and the Drop logo are trademarks of Global Life Sciences IP Holdco LLC or an affiliate. 

© 2020 Cytiva. 
All goods and services are sold subject to the terms and conditions of sale of the supplying company operating 
within the Cytiva business. A copy of those terms and conditions is available on request. Contact your local Cytiva 
representative for the most current information. 

For local office contact information, visit cytiva.com/contact. 
28980026 AD 04/2020 
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Product return or servicing

 

Health & Safety Declaration Form 
for Product Return or Servicing 

 
 

Return authorization 
number: 

 and/or 
Service Ticket/Request: 

 

To make sure the mutual protection and safety of Cytiva personnel, our customers, transportation personnel and our environment, 

all equipment must be clean and free of any hazardous contaminants before shipping to Cytiva. To avoid delays in the processing of 

your equipment, complete this checklist and include it with your return. 

1. Note that items will NOT be accepted for servicing or return without this form 

2. Equipment which is not sufficiently cleaned prior to return to Cytiva may lead to delays in servicing the equipment and 

could be subject to additional charges 

3. Visible contamination will be assumed hazardous and additional cleaning and decontamination charges will be applied 

 Yes   No Specify if the equipment has been in contact with any of the following: 

  Radioactivity (specify)  

  Infectious or hazardous biological substances (specify)  

  Other Hazardous Chemicals (specify)  

Equipment must be decontaminated prior to service / return. Provide a telephone number where Cytiva can contact 
you for additional information concerning the system / equipment. 

Telephone No:   

Liquid and/or gas in equipment is:  Water 

 Ethanol 

 None, empty 

 Argon, Helium, Nitrogen 

 Liquid Nitrogen 

Other, specify  

Equipment type / Product No:  Serial No:  

I hereby confirm that the equipment specified above has been cleaned to remove any hazardous substances and that 
the area has been made safe and accessible. 

Name: 
 Company or 

institution:   
 

Position or job title:  Date (YYYY/MM/DD)  

Signed:   

Cytiva and the Drop logo are trademarks of Global Life Sciences IP Holdco LLC or an affiliate. 

© 2020 Cytiva. 
All goods and services are sold subject to the terms and conditions of sale of the supplying company operating 
within the Cytiva business. A copy of those terms and conditions is available on request. Contact your local Cytiva 
representative for the most current information. 

For local office contact information, visit cytiva.com/contact. 
28980027 AD 04/2020 

To receive a return authorization number 
or service number, call local 
technical support or customer service.  
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Appendix A

Create a method with UNICORN 5

About this chapter
This chapter describes how to create a method for UniFlux 10 system in the UNICORN
Method Editor.

In a basic example, the general structure of a method is shown, along with the different
steps required to create it.

For information about methods in general, and for detailed information about the
Method Editor, refer to the UNICORN manuals.

In this chapter

Section See page

A.1 The Method Editor 170

A.2 An example of using the Method Editor 176

A. Create a method with UNICORN 5
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A.1 The Method Editor

In this section

Section See page

A.1.1 Introduction to the Method Editor 171

A.1.2 Method Editor layout 173

A.1.3 Other Method Editor features 175

A. Create a method with UNICORN 5
A.1 The Method Editor
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A.1.1 Introduction to the Method Editor

Description
The Method Editor is used to build new methods in a step-by-step manner using
blocks and instructions as building elements. The Method Editor can also be used to
edit already existing methods.

Blocks
Blocks are used to organize instructions into functional units. A block may, for instance,
contain instructions for washing a filter/cartridge. Blocks can be nested (i.e., a block
can contain other blocks).

Blocks are useful for organizing instructions and structuring methods, and also allow
for reuse of existing sets of instructions. Individual blocks can be moved and used in
any method (within the same strategy) as required.

Create a block

The general procedure to create a block in the Method Editor is:

Step Action

1 Select Block →New... from the menu.

2 In the dialog shown, give the block a name and select the type of Base (Time
or Volume) for the block. The choice of base depends on the function of the
block.

A. Create a method with UNICORN 5
A.1 The Method Editor

A.1.1 Introduction to the Method Editor

UniFlux 10 Operating Instructions 28993587 AF 171



Open the Method Editor

Open the Method Editor window from the UNICORN Manager module by selecting it
in the task bar at the bottom of the screen.

Step Action

1 Click on the Customize Panes icon in the Method Editor toolbar.

2 Select Text and Instruction box in the Customize Panes dialog shown.

3 Click OK.

The upper part of the Method Editor window now shows the Text pane and
the lower part the Instruction box. It is also possible to show an optional
flow diagram, or a block diagram in the Method Editor, by selecting the
appropriate items in the Customize Panes dialog. These diagrams can help
when programming advanced methods, but are not required for building or
editing a method. They are therefore not included in the following discus-
sion.
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A.1.2 Method Editor layout

Text pane

The Text pane contains an overview of the
method in the form of an expandable list with
all blocks and instructions in the method.
Blocks are marked by blue square symbols.
The figure to the right shows a method with
several blocks and instructions. For a newly
created method, only the Main block is
shown, with a defined Base.

The list in the Text pane has a tree structure
and individual blocks can be expanded or
contracted, as indicated by the + or - signs.
When expanded, all the block instructions
and nested blocks are displayed and avail-
able for editing.

Editing is done in the Instruction box in the
lower part of the Method Editor window.

Instruction box
The parameters for the block or instruction that is currently selected in the Text pane
are displayed and available for editing in the Instruction box in the lower part of the
Method Editor window.

The Instruction box is divided into four areas. These are, from left to right:

• Breakpoint — Contains a field for setting the breakpoint for the instruction or
block, in the unit currently selected as Base (Time or Volume).

• Instructions — Contains controls for selecting an instruction from a list. The
instructions available are grouped according to function. Groups are selected using
the radio buttons to the left of the list area.

• Parameters — Contains parameter fields for the chosen instruction. The parame-
ters will vary between the different instructions.

• Buttons — There are four buttons: Insert, Change, Replace, and Delete. Change,
Replace and Delete affect the instruction or block currently selected in the Text
pane. Insert adds a new instruction before, or after (if it has the same breakpoint as
an old instruction), the current selection.
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Note: Changing the Breakpoint of an instruction using Change will move not
only the instruction, but also all subsequent instructions in the block. Using
Replace moves only the selected instruction.

Instructions placed at the same breakpoint will execute simultaneously, while blocks
will execute in the order they occur in the Text pane.

Changing valve positions, or changing the speed of the pump does not take place
momentarily, but requires a small amount of time. A small time lag, such as 0.10 min,
should therefore be introduced after time-based instructions affecting mechanical
components.

Note: There is no undo-function in UNICORN for BioProcess and you are therefore
recommended to regularly save the method you are working with, pref-
erably using different version numbers.
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A.1.3 Other Method Editor features

Introduction
The method created in the following chapter covers the most basic aspects of how a
method is built. Follow this example to learn the basics of designing a filtration method.

A few useful features demonstrated in this example are briefly described here.

Variables

There is one Var... button in the Breakpoint field and one Var... button for each
parameter in the Parameters field.

These are used to create variables representing breakpoints or parameters. Variables
enable reuse of defined breakpoints and instructions in other blocks.

Totalizers

A totalizer monitors the accumulated volumes passing through the flow meters. For
each totalizer, there is a watch instruction allowing easy programming of desired
actions triggered by specific events.

Follow the instruction below to define an action based on the totalizer, for instance for
the permeate volume.

Step Action

1 Reset the totalizer to 0 liters by inserting instruction FT142VTot_Reset
(under Permeate).

2 Insert watch instruction Watch_FT142VTot (under Watch) and set values
for Test (e.g., Greater_Than), Value (volume in liters) and Action (e.g.,
END_BLOCK).

The allowed noise, or error, for a totalizer can be defined using the appropriate
FT14VTot_WatchPar instruction (under Specials).
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A.2 An example of using the Method Editor

In this section

Section See page

A.2.1 Introduction 177

A.2.2 Create the method 179

A.2.3 Block 1: Initial conditions 182

A.2.4 Block 2: Product transfer 185

A.2.5 Block 3: Fed-batch concentration 191

A.2.6 Saving the method 201
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A.2.1 Introduction

About the example
Create a method involves:

1. Creating and naming the method.

2. Adding the blocks and instructions to it.

In this section, a basic example is used to illustrate the different steps required.

The steps are explained in detail at the beginning and more briefly in the later parts, as
the user becomes familiar with the interaction.

NOTICE

The method used in this example is for training purpose only. It is
not intended as an example of a production method.

Tip:

Modify an instruction by selecting it in the Text pane and make the changes
in the Instruction box.

Tip:
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Save your method at regular intervals while developing it by pressing the
disk-icon or select File →Save in the menu.

Preconditions
In order to create a method, the following preconditions must be fulfilled:

• A strategy, valid for the system must be installed.1

• UNICORN must be installed on a stand-alone computer connected to the UniFlux 10
system.1

• UNICORN must be running.

• The correct system must be selected in UNICORN.1

• The method developer must have a basic knowledge on how the UNICORN Method
Editor is used.

1 Installed on customer site.
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A.2.2 Create the method
This step creates the method and sets some initial conditions to it.

Step Action

1

Select File →New in the Method Editor menu.
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Step Action

2

In the New Method dialog shown:

a. Select the desired system.

b. Select Method Editor (pre-selected).

c. Click OK.

The new method will be displayed in the Text pane as the Main block with a
single Base Time instruction.
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Step Action

3 This instruction is required to avoid repeated display of the warning
message "No flow in beginning of method".

a. In the Text pane, select the Base Time instruction.

b. In the Instruction box, do the following settings:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Other and Flow_Warning.

• In the Parameters field, set Mode to Disabled.

• Click the Insert button.

The new instruction will now show up in the Text pane below Base Time.
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A.2.3 Block 1: Initial conditions

Purpose
The first block in the method will set the filter area and the pressure alarms.

Block: Initial conditions

Step Action

1 In the Text pane, select the Base Time instruction of the Main node.

2

In the Method Editor menu, select Block →New.

3

In the New Block dialog shown, do the following settings:

• In the Name field, type an appropriate name, for instance
INITAL_CONDITIONS (space is not allowed).

• In the Base group box, select Time.

• In the Call group box, select Main.

• Click OK to insert the new block.
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Instruction: Membrane area

Step Action

1

In the Text pane, expand the Block INITIAL_CONDITIONS block by clicking
the + to the left of the block.

2

In the Block INITIAL_CONDITIONS instructions list, select the Base Time
instruction.

3 In the Instruction box, do the following settings:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Specials and
Total_Membrane_Surface_Area.

• In the Parameters field, set Area to the correct value in m2, depending
on your filter setup.

• Click the Insert button.

The new instruction will now be displayed in the Text pane.
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Instructions: Filter pressure alarm

Step Action

1 In the Text pane, select the Base Time instruction of the Block
INITIAL_CONDITIONS block.

2 In the Instruction box, do the following settings:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Alarms and DeltaP_Alarms.

• In the Parameters field, set High Alarm, Low Alarm, High Warn and
Low Warn to appropriate values according to the specifications for the
filter in use.

• In the Parameters field, set Mode to Enabled.

• Click the Insert button.

Instructions: TMP alarm

Step Action

1 In the Text pane, select the Base Time instruction of the Block
INITIAL_CONDITIONS block.

2 In the Instruction box, do the following settings:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Alarms and TMP_Alarms.

• In the Parameters field, set High Alarm, Low Alarm, High Warn and
Low Warn to appropriate values according to the specifications for the
filter in use or requirements of the intended application (if lower than
filter specifications).

• In the Parameters field, set Mode to Enabled.

• Click the Insert button.
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A.2.4 Block 2: Product transfer

Purpose and structure
The second block in the method will fill the tank with the solution to be processed.

This block will contain nested blocks.

Block: Product transfer

Step Action

1 In the Text pane, select the Base Time instruction of the Main node.

2 In the Method Editor menu, select Block →New.

3 In the New Block dialog:

• In the Name field, type an appropriate name, for instance
PRODUCT_TRANSFER.

• In the Base group box, select Time.

• In the Call group box, select Main.

• Click OK to insert the new block.

Nested block: Product transfer path

Step Action

1 In the Text pane, select the Base Time instruction of the Block
PRODUCT_TRANSFER block.

2 In the Method Editor menu, select Block →New.

3 In the New Block dialog:

• In the Name field, type an appropriate name, for instance
PRODUCT_TRANSFER_FLOWPATH.

• In the Base group box, select Time.

• In the Call group box, select Block PRODUCT_TRANSFER.

• Click OK to insert the new block.

The new block will be placed inside the Block PRODUCT_TRANSFER block.
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Instruction: Recirculation loop

Step Action

1 In the Text pane, select the Base Time instruction of the Block
PRODUCT_TRANSFER_FLOWPATH block.

2 In the Instruction box:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Recirc.

3 Select Feed, set to Open, click Insert.

4 Select Feed_Drain, set to Closed, click Insert.

5 Select IntegrityTestValve, set to Closed, click Insert.

6 Select Retentate_Control_Valve_PCV341, set to 100 %, click Insert.

7 Select Retentate, set to Retentate, click Insert.

Instruction: Permeate outlets

Step Action

1 In the Text pane, select the Base Time instruction of the Block
PRODUCT_TRANSFER_FLOWPATH block.

2 In the Instruction box:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Permeate.

3 Select Permeate, set to Closed, click Insert.

4 Select Permeate_Drain, set to Closed, click Insert.

Progress review
The Method Editor should now look something like this.
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Nested block: Delay to allow the
valves to react

Step Action

1 In the Text pane, select the Base Time instruction of the Block
PRODUCT_TRANSFER_FLOWPATH block

2 In the Method Editor menu, select Block →New.

3 In the New Block dialog:

• In the Name field, type an appropriate name, for instance DELAY_3_SEC.

• In the Base group box, select Time.

• In the Call group box, select Block PRODUCT_TRANSFER_FLOWPATH.

• Click OK to insert the new block.

The new block will be placed inside the Block
PRODUCT_TRANSFER_FLOWPATH block.

4 In the Text pane, select the End_Block instruction of the Block
DELAY_3_SEC block.

5 In the Instruction box:

• Set Breakpoint to 0.05 min (equals 3 seconds).

• Click the Change button.
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Nested block: Start and stop the
product transfer

Step Action

1 In the Text pane, select the Base Time instruction of the Block
PRODUCT_TRANSFER block.

2 In the Method Editor menu, select Block →New.

3 In the New Block dialog:

• In the Name field, type an appropriate name, for instance
PRODUCT_TRANSFER_VOLUME.

• In the Base group box, select Time.

• In the Call group box, select From →Block PRODUCT_TRANSFER and
At →0.00 min.

• Click OK to insert the new block.

The new block will be placed inside the Block PRODUCT_TRANSFER block.

Instruction: Transfer feed pump

Step Action

1 In the Text pane, select the Base Time instruction of the Block
PRODUCT_TRANSFER_VOLUME block.

2 In the Instruction box:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Recirc.

• Select TransferFeedPump, set Flow to 90%, click Insert.

Instruction: Tank level watch

Step Action

1 In the Text pane, select the Base Time instruction of the Block
PRODUCT_TRANSFER_VOLUME block.
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Step Action

2 In the Instruction box:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Watch and WatchTankLevel.

• Set:

a. Test to Greater_Than.

b. Value to a number in liters given by the tank specification or the
application requirements.

c. Action to END_BLOCK.

• Click the Insert button.

End block: Allow the tank to be filled

Step Action

1 In the Text pane, select the End_Block instruction of the Block
PRODUCT_TRANSFER_VOLUME block.

2 In the Instruction box:

• Set Breakpoint to a value high enough for the tank to reach the volume
set for WatchTankLevel (in the previous step).

• Click the Change button.

Progress review
The Method Editor window should now look something like this.
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A.2.5 Block 3: Fed-batch concentration

Purpose and structure
This block will start the concentration of the feed.

Block: Fed-batch concentration

Step Action

1 In the Text pane, select the Base Time instruction of the Main node.

2 In the Method Editor menu, select Block →New.

3 In the New Block dialog:

• In the Name field, type an appropriate name, for instance
FED_BATCH_CONCENTRATION.

• In the Base group box, select Time.

• In the Call group box, select Main.

• Click OK to insert the new block.

Nested block: Feed concentration
flow path

Step Action

1 In the Text pane, select the Base Time instruction of the Block
FED_BATCH_CONCENTRATION block.

2 In the Method Editor menu, select Block →New.

3 In the New Block dialog:

• In the Name field, type an appropriate name, for instance
FLOWPATH_CONCENTRATION.

• In the Base group box, select Time.

• In the Call group box, select From →Block
FED_BATCH_CONCENTRATION and At →0.00 min.

• Click OK to insert the new block.

The new block will be placed inside the Block
FED_BATCH_CONCENTRATION block.
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Instructions: Recirculation loop

Step Action

1 In the Text pane, select the Base Time instruction of the Block
FLOWPATH_CONCENTRATION block.

2 In the Instruction box:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Recirc.

3 Set Feed to Open, click Insert.

4 Set Feed_Drain to Closed, click Insert.

5 Set IntegrityTestValve to Closed, click Insert.

6 Set Retentate_Control_Valve_PCV341 to 100%, click Insert.

7 Set Retentate to Retentate, click Insert.

Instructions: Permeate outlets

Step Action

1 In the Text pane, select the Base Time instruction of the Block
FLOWPATH_CONCENTRATION block.

2 In the Instruction box:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Permeate.

3 Set Permeate_Drain to Closed, click Insert.

4 Set Permeate to Permeate, click Insert.

Nested block: Delay to allow the
valves to react

Here, the 3 second delay block created earlier will be reused to allow all valves to react.

Step Action

1 In the Text pane, select the last instruction before the End_Block instruc-
tion of the Block FLOWPATH_CONCENTRATION block.
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Step Action

2 In the Instruction box:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Other and Block.

3 In the Parameters field, select the Block DELAY_3_SEC block.

4 Click Insert.

Nested block: Fed-batch
concentration parameters

Step Action

1 In the Text pane, select the Base Time instruction of the Block
FED_BATCH_CONCENTRATION block.

2 In the Method Editor menu, select Block →New.

3 In the New Block dialog:

• In the Name field, type an appropriate name, for instance
PARAMETERS_CONCENTRATION.

• In the Base group box, select Time.

• In the Call group box, select From →Block
FED_BATCH_CONCENTRATION and At →0.00 min.

• Click OK to insert the new block.

The new block will be placed inside the Block
FED_BATCH_CONCENTRATION block.

Instruction: Tank level and hysteresis

Step Action

1 In the Text pane, select the Base Time instruction of the Block
PARAMETERS_CONCENTRATION block.

2 In the Instruction box:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Recirc and TankLevel.
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Step Action

3 In the Parameters field:

• Check Maintain or set Setpoint for the tank level to a desired value.

• Set Hysteresis to an appropriate value, for instance 0.5 l.

• Set Tank Fill to Enabled.

4 Click Insert.

Instruction: Transfer feed setup

Step Action

1 In the Text pane, select the Base Time instruction of the Block
PARAMETERS_CONCENTRATION block.

2 In the Instruction box:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Recirc and TransferFeedPump.

3 In the Parameters field:

• Set Setpoint (that is the pump flow) to 50%.

• Set StartMode to TankFill.

4 Click Insert.

Instruction: Reset the flow meter
totalizer

Step Action

1 In the Text pane, select the Base Time instruction of the Block
PARAMETERS_CONCENTRATION block.

2 In the Instruction box:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Permeate and FIT142Tot_Reset.

3 Click Insert.
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Instruction: Start concentration
factor calculation

Step Action

1 In the Text pane, select the Base Time instruction of the Block
PARAMETERS_CONCENTRATION block.

2 In the Instruction box:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Recirc and
ConcFac_FedBatch_On.

3 Click Insert.

Progress review
The Method Editor should now look something like this.

Nested block: Stable differential
pressure (Delta P)

This block ensures that a stable Delta P value is reached.
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Step Action

1 In the Text pane, select the Base Time instruction of the Block
FED_BATCH_CONCENTRATION block.

2 In the Method Editor menu, select Block →New.

3 In the New Block dialog:

• In the Name field, type an appropriate name, for instance
STABLE_DELTA_P.

• In the Base group box, select Time.

• In the Call group box, select From →Block
FED_BATCH_CONCENTRATION and At →0.00 min.

• Click OK to insert the new block.

The new block will be placed inside the Block
FED_BATCH_CONCENTRATION block.

Instruction: Setting Delta P value

Step Action

1 In the Text pane, select the Base Time instruction of the Block
STABLE_DELTA_P block.

2 In the Instruction box:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Recirc and DeltaP.

3 In the Parameters field, set Setpoint to an appropriate value, for instance
1.5 bar.

4 Click Insert.

Instruction: Setting Delta P
variations

Step Action

1 In the Text pane, select the Base Time instruction of the Block
STABLE_DELTA_P block.

2 In the Instruction box:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Specials and DeltaP_WatchPar.
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Step Action

3 In the Parameters field:

• Set BaseLine to for instance 0.1 bar.

• Set MinPeak to 0.00 bar.

4 Click Insert.

Instruction: Setting Delta P watch

Step Action

1 In the Text pane, select the Base Time instruction of the Block
STABLE_DELTA_P block.

2 In the Instruction box:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Watch and Watch_DeltaP.

3 In the Parameters field:

• Set Test to Stable_Baseline.

• Set Minutes to 1.0.

• Set Action to END_BLOCK.

4 Click Insert.

Set block end time

Change the block end time to 10 minutes to give Delta P some time to stabilize.

Step Action

1 In the Text pane, select the End_Block instruction of the Block
STABLE_DELTA_P block.

2 In the Instruction box, set Breakpoint to 10.00 min.

3 Click Change.

Nested block: Trans membrane
pressure (TMP) setup

This block sets the TMP value.
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Step Action

1 In the Text pane, select the Base Time instruction of the Block
FED_BATCH_CONCENTRATION block.

2 In the Method Editor menu, select Block →New.

3 In the New Block dialog:

• In the Name field, type an appropriate name, for instance
TMP_START_STOP.

• In the Base group box, select Time.

• In the Call group box, select From →Block
FED_BATCH_CONCENTRATION and At →0.00 min.

• Click OK to insert the new block.

The new block will be placed inside the Block
FED_BATCH_CONCENTRATION block.

Instruction: Setting the TMP value

Step Action

1 In the Text pane, select the Base Time instruction of the Block
TMP_START_STOP block.

2 In the Instruction box:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Recirc and TMP.

3 In the Parameters field, set Setpoint to an appropriate value, for instance
1.0 bar.

4 Click Insert.

Instruction: Set the tank level watch

Step Action

1 In the Text pane, select the Base Time instruction of the Block
TMP_START_STOP block.

2 In the Instruction box:

• Set Breakpoint to 0.00 min.

• In the Instructions group box, select Watch and Watch_FIT142VTot.
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Step Action

3 In the Parameters field:

• Set Test to Greater_Than.

• Set Value to an appropriate permeate volume.

• Set Action to END_BLOCK.

4 Click Insert.

Set block end time

Change the block end time so that the tank level has time to reach the volume set in
the tank level watch.

Step Action

1 In the Text pane, select the End_Block instruction of the Block
TMP_START_STOP block.

2 In the Instruction box, set Breakpoint to a suitable time, for instance
60.00 min.

3 Click Change.

Progress review
If all the steps described above have been performed, the Method Editor window
should now look something like this.
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If any step appears to be missing, misplaced or carries incorrect values, use the various
editing methods available in the Method Editor to correct the errors.
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A.2.6 Saving the method

To save the method, click the discette icon or select File →Save in the menu.
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Appendix B

Create a method with UNICORN 6 and
above

About this chapter
This chapter describes how to create a method for UniFlux 10 system in the UNICORN
Method Editor.

In a basic example, the general structure of a method is shown, along with the different
steps required to create it.

For information about methods in general, and for detailed information about the
Method Editor, refer to the UNICORN manuals.

In this chapter

Section See page

B.1 The Method Editor 203

B.2 An example of using the Method Editor 209
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B.1 The Method Editor

In this section

Section See page
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B.1.1 Introduction to the Method Editor

Description
The Method Editor is used to build new methods in a step-by-step manner using
phases, blocks and instructions as building elements. The Method Editor can also be
used to edit already existing methods.

Phases and blocks
Phases and blocks are used to organize instructions into functional units. A phase may,
for instance, contain instructions for washing a filter/cartridge. Phases and blocks can
be nested (i.e., a block can contain other blocks).

Phases and blocks are useful for organizing instructions and structuring methods, and
also allow for reuse of existing sets of instructions. Individual phases and blocks can be
moved and used in any method (within the same configuration) as required.

For detailed descriptions of phases and blocks, refer to the UNICORN manuals.

Note: There are no predefined phases for the UniFlux 10 systems.

Create a phase

A new empty method has the Method Settings phase in the Method Outline.

The table below describes how to add a phase to the Method Outline using drag-and-
drop.

Step Action

1 Select the User Defined phase in the Phase Library pane and drag-and-
drop the phase to the requested position in the Method Outline pane.

Result:

The phase is included in the method at the requested position.
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Step Action

2 When the User Defined phase has been added to the Method Outline, the
phase name is enabled for editing.

Type a name for the phase and press the Return keyboard key.

Note:

The User Defined phase is marked with the letter T, meaning that it is text
edited. This phase contains only Base and End_Block instructions, so any
functional instruction must be added manually.

3 To include instructions for the User Defined phase, select the Text
Instructions tab and text edit the method.

Note:

The Phase Properties tab will show a list of variables used in the phase.

Create a block

Follow this general procedure to create a block in the Method Editor.

Step Action

1 In the Instruction Box:

In the Instructions: list, select Other and Block.

2 In the Parameters for field, type an appropriate name.

3 Click the Insert button.
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B.1.2 Method Editor layout

Text Instructions tab
Click the Method Editor window from UNICORN by selecting it in the task bar at the
bottom of the screen.

The Text Instructions tab contains an over-
view of the method in the form of an expand-
able list with all phases, blocks and instruc-
tions in the method. Phases and blocks are
marked by blue square symbols. The figure to
the right shows a method with several
phases, blocks and instructions. For a newly
created method, only the Method Settings
phase is shown in the Method Outline.

The list in the Text Instructions tab has a
tree structure and individual blocks can be
expanded or contracted, as indicated by the
+ or - signs. When expanded, all the block
instructions and nested blocks are displayed
and available for editing.

Editing is done in the Instruction Box below
the Text Instructions tab.

Instruction Box
The parameters for the block or instruction that is currently selected in the Text
Instructions tab are displayed and available for editing in the Instruction Box below
the Text Instructions tab.

• Breakpoint — Contains a field for setting the breakpoint for the instruction or
block, in the unit currently selected as Base (Time or Volume).
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• Instructions: — Contains controls for selecting an instruction from a list. The
instructions available are grouped according to function.

• Parameters for — Contains parameter fields for the chosen instruction. The
parameters will vary between the different instructions.

• Buttons — There are four buttons: Insert, Change, Replace, and Delete. Change,
Replace and Delete affect the instruction or block currently selected in the Text
Instructions tab. Insert adds a new instruction before, or after (if it has the same
breakpoint as an old instruction), the current selection.

Note: Changing the breakpoint of an instruction using Change will move not only
the instruction, but also all subsequent instructions in the block. Using
Replace moves only the selected instruction.

Instructions placed at the same breakpoint will execute simultaneously, while blocks
will execute in the order they occur in the Text Instructions tab.

Changing valve positions, or changing the speed of the pump does not take place
momentarily, but requires a small amount of time. A small time lag, such as 0.10 min,
should therefore be introduced after time-based instructions affecting mechanical
components.
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B.1.3 Other Method Editor features

Introduction
The method created in the following chapter covers the most basic aspects of how a
method is built. Follow this example to learn the basics of designing a filtration method.

A few useful features demonstrated in this example are briefly described here.

Variables

There is one Var... button in the Breakpoint field and one Var... button for each
parameter in the Parameters for field.

These are used to create variables representing breakpoints or parameters. Variables
enables reuse of defined breakpoints and instructions in other blocks.

Totalizers

A totalizer monitors the accumulated volumes passing through the flow meters. For
each totalizer there is a watch instruction allowing easy programming of desired
actions triggered by specific events.

Follow the instruction below to define an action based on the totalizer, for instance for
the permeate volume.

Step Action

1 Reset the totalizer to 0 liters by inserting instruction FT142VTot_Reset
(under Permeate).

2 Insert watch instruction (under Watch) and set values for Signal
(FT142Vtot), Test (e.g., Greater_Than), Value (volume in liters) and
Action (e.g., End block).

The allowed noise, or error, for a totalizer can be defined using the appropriate
FT14VTot_WatchPar instruction (under Specials).
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B.2 An example of using the Method Editor

In this section

Section See page
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B.2.1 Introduction

About the example
Create a method involves the following steps:

1. Creating and naming the method.

2. Adding the blocks and instructions to it.

In this section, a basic example is used to illustrate the different steps in the procedure.

The steps are explained in detail at the beginning and more briefly in the later parts, as
the user becomes familiar with the interaction.

NOTICE

The method used in this example is for training purpose only. It is
not intended as an example of a production method.

Tip:

Modify an instruction by selecting it in the Text Instructions tab and make
the changes in the Instruction Box.
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Tip:

Save your method at regular intervals while developing it by pressing the
disk-icon or select File →Save in the menu.

Preconditions
In order to create a method, the following preconditions must be fulfilled:

• A configuration, valid for the system must be installed.1

• UNICORN must be installed on a stand-alone computer connected to the UniFlux 10
system.1

• UNICORN must be running.

• The correct system must be selected in UNICORN.1

• The method developer must have a basic knowledge on how the UNICORN Method
Editor is used.

1 Installed on customer site.
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B.2.2 Create the method
The following step creates the method and sets some initial conditions to it.

Step Action

1

Select File →New Method in the Method Editor menu.
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Step Action

2

In the New Method dialog shown:

a. Select the desired system.

b. Click OK.

The new method will be displayed in the Text Instructions tab.

The new method starts with the Phase →Method Settings phase, for
UniFlux 10 systems this contains a Base →SameAsMain instruction and
an End_Block instruction.

c. Under the Main node, select the Base: instruction.

d. In the Instruction Box, select Other and set the instruction Base
parameter Column Type to Any, and the Base parameter to Time.
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B.2.3 Phase 1: Method Settings

Purpose
The first phase in the method will set the filter area and the pressure alarms.

Phase: Method Settings

This instruction is required to avoid repeated display of the warning message "No flow
in beginning of method".

Step Action

1 In the Text Instructions tab, expand the Phase →Method Settings phase
by pressing the + to the left of the phase.

2 Select the Base →SameAsMain instruction of the Phase →Method
Settings phase.
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Step Action

3 In the Instruction Box, do the following settings:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Other and Flow_Warning.

• In the Parameters for field, set Mode to Disabled.

• Click the Insert button.

The new instruction will now show up in the Text Instructions tab below
Base →SameAsMain.
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Instruction: Membrane area

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Phase →Method Settings phase.

2 In the Instruction Box, do the following settings:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Specials and
Total_Membrane_Surface_Area.

• In the Parameters for field, set Area to the correct value in m2
depending on your filter setup.

• Click the Insert button.

The new instruction will now be displayed in the Text Instructions tab.

Instructions: Filter pressure alarm

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Phase →Method Settings phase.
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Step Action

2 In the Instruction Box, do the following settings:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Alarms and DeltaP_Alarms.

• In the Parameters for field, set High Alarm, Low Alarm, High Warn
and Low Warn to appropriate values according to the specifications for
the filter in use.

• In the Parameters for field, set Mode to Enabled.

• Click the Insert button.

Instructions: TMP alarm

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Phase →Method Settings phase.

2 In the Instruction Box, do the following settings:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Alarms and TMP_Alarms.

• In the Parameters for field, set High Alarm, Low Alarm, High Warn
and Low Warn to appropriate values according to the specifications for
the filter in use or requirements of the intended application (if lower than
filter specifications).

• In the Parameters for field, set Mode to Enabled.

• Click the Insert button.
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B.2.4 Phase 2: Product Transfer

Purpose and structure
The second phase in the method will fill the tank with the solution to be processed.

This phase will contain nested blocks.

Creating a phase: Product Transfer

Follow the instructions below to create a new phase.

Step Action

1 Select the phase in the Phase Library pane and drag-and-drop the phase to
the requested position in the Method Outline pane. In the example, a User
Defined phase is used.

Result:

The phase is included in the method at the requested position.

2 When the User Defined phase has been added to the Method Outline, the
phase name is enabled for editing.

Type a name for the phase, for instance Product Transfer, and press the
Return keyboard key.

Note:

The Product Transfer phase is marked with the letter T, meaning that it is
text edited. This phase contains only Base and End_Block instructions, so
any functional instructions must be added manually.

3 To include instructions for the Phase →Product Transfer phase, select the
Text Instructions tab and text edit the method.

Note:

The Phase Properties tab will show a list of variables used in the phase.
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Nested block: Product Transfer path

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Phase →Product Transfer phase.

2 In the Instruction Box, do the following settings:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Other and Block.

• In the Parameters for field, type an appropriate name, for instance
PROD_TRANSFER_FLOWPATH.

• Click the Insert button.

The new block will be placed inside the Phase →Product Transfer phase.

Instruction: Recirculation loop

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Block →PROD_TRANSFER_FLOWPATH block.

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Recirc.

3 Select Feed, set to Open, click Insert.

4 Select Feed_Drain, set to Closed, click Insert.

5 Select IntegrityTestValve, set to Closed, click Insert.

6 Select Retentate_Control_Valve_PCV341, set to 100%, click Insert.

7 Select Retentate, set to Retentate, click Insert.

Instruction: Permeate outlets

Step Action

1 In the Text Instructions tab, select the Base: SameAsMain instruction of
the Block →PROD_TRANSFER_FLOWPATH block.
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Step Action

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Permeate.

3 Select Permeate, set to Closed, click Insert.

4 Select Permeate_Drain, set to Closed, click Insert.

Progress review
The Method Editor should now look something like this.
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Nested block: Delay to allow the
valves to react

Step Action

1 In the Text Instructions tab, select the last instruction before the
End_Block instruction of the Block →PROD_TRANSFER_FLOWPATH
block.

2 In the Instruction Box, do the following settings:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Other and Block.

• In the Parameters for field, type an appropriate name, for instance
DELAY_3_SEC.

• Click the Insert button.

The new block will be placed inside the Block →PROD_TRANSFER_FLOW-
PATH block.

3 In the Text Instructions tab, select the End_Block instruction of the Block
→DELAY_3_SEC block.

4 In the Instruction Box:

• Set Breakpoint to 0.05 min (equals 3 seconds).

• Click the Change button.

Nested block: Start and stop the
product transfer

Step Action

1 In the Text Instructions tab, select the Block →PROD_TRANSFER_FLOW-
PATH instruction of the Phase →Product transfer phase.

2 In the Instruction Box, do the following settings:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Other and Block.

• In the Parameters for field, type an appropriate name, for instance
PROD_TRANSFER_VOLUME.

• Click the Insert button.
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Instruction: Transfer feed pump

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Block →PROD_TRANSFER_VOLUME block.

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Recirc.

• Select TransferFeedPump, set Flow to 90%, click Insert.

Instruction: Tank level watch

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Block →PROD_TRANSFER_VOLUME block.

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Watch and Watch.

• Set:

a. Signal to Tank_Level.

b. Test to Greater_Than.

c. Value to a number in liters given by the tank specification or the
application requirements.

d. Action to End block.

• Click the Insert button.

End block: Allow the tank to be filled

Step Action

1 In the Text Instructions tab, select the End_Block instruction of the Block
→PROD_TRANSFER_VOLUME block.

2 In the Instruction Box:

• Set Breakpoint to a value high enough for the tank to reach the volume
set for Watch (in the previous step).

• Click the Change button.
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Progress review
The Method Editor window should now look something like this.
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B.2.5 Phase 3: Fed Batch Concentration

Purpose and structure
This phase will start the concentration of the feed.

Creating a phase: Fed Batch
Concentration

Follow the instructions below to create a new phase.

Step Action

1 Select the phase in the Phase Library pane and drag-and-drop the phase to
the requested position in the Method Outline pane. In the example, a User
Defined phase is used.

Result:

The phase is included in the method at the requested position.

2 When the User Defined phase has been added to the Method Outline, the
phase name is enabled for editing.

Type a name for the phase, for instance Fed Batch Concentration, and
press the Return keyboard key.

Note:

The Fed Batch Concentration phase is marked with the letter T, meaning
that it is text edited. This phase contains only Base and End_Block instruc-
tions, so any functional instructions must be added manually.

B. Create a method with UNICORN 6 and above
B.2 An example of using the Method Editor

B.2.5 Phase 3: Fed Batch Concentration
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Step Action

3 To include instructions for the Phase →Fed Batch Concentration phase,
select the Text Instructions tab and text edit the method.

Note:

The Phase Properties tab will show a list of variables used in the phase.

Nested block: Feed concentration
flow path

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Phase →Fed Batch Concentration phase.

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Other and Block.

• In the Parameters for field, type an appropriate name, for instance
FLOWPATH_CONCENTRATION.

• Click the Insert button.

The new block will be placed inside the Phase →Fed Batch Concentration
phase.

Instructions: Recirculation loop

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Block →FLOWPATH_CONCENTRATION block.

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Recirc.

3 Set Feed to Open, click Insert.

4 Set Feed_Drain to Closed, click Insert.

B. Create a method with UNICORN 6 and above
B.2 An example of using the Method Editor
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Step Action

5 Set IntegrityTestValve to Closed, click Insert.

6 Set Retentate_Control_Valve_PCV341 to 100%, click Insert.

7 Set Retentate to Retentate, click Insert.

Instructions: Permeate outlets

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Block →FLOWPATH_CONCENTRATION block.

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Permeate.

3 Set Permeate_Drain to Closed, click Insert.

4 Set Permeate to Permeate, click Insert.

Nested block: Delay to allow the
valves to react

In this block, the 3 second delay block created earlier will be reused to allow all valves to
react.

Step Action

1 In the Text Instructions tab, select the last instruction before the
End_Block instruction of the Block →FLOWPATH_CONCENTRATION
block.

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Other and Block.

3 In the Parameters for field, select the Block →DELAY_3_SEC block.

4 Click Insert.

B. Create a method with UNICORN 6 and above
B.2 An example of using the Method Editor
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Nested block: Fed Batch
Concentration parameters

Step Action

1 In the Text Instructions tab, select the Block →FLOWPATH_CONCEN-
TRATION instruction of the Phase →Fed Batch Concentration phase.

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Other and Block.

• In the Parameters for field, type an appropriate name, for instance
PARAMETERS_CONCENTRATION.

• Click Insert.

The new block will be placed inside the Phase →Fed Batch Concentration
phase.

Instruction: Tank level and hysteresis

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Block →PARAMETERS_CONCENTRATION block.

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Recirc and TankLevel.

3 In the Parameters for field:

• Check Maintain or set Setpoint for the tank level to a desired value.

• Set Hysteresis to an appropriate value, for instance 0.5 l.

• Set Tank Fill to Enabled.

4 Click Insert.

Instruction: Transfer feed setup

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Block →PARAMETERS_CONCENTRATION block.

B. Create a method with UNICORN 6 and above
B.2 An example of using the Method Editor
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Step Action

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Recirc and TransferFeedPump.

3 In the Parameters for field:

• Set Setpoint (that is the pump flow) to 50%.

• Set StartMode to TankFill.

4 Click Insert.

Instruction: Reset the flow meter
totalizer

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Block →PARAMETERS_CONCENTRATION block.

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Permeate and FIT142Tot_Reset.

3 Click Insert.

Instruction: Start concentration
factor calculation

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Block →PARAMETERS_CONCENTRATION block.

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Recirc and ConcFac_FedBatch_On.

3 Click Insert.

Progress review
The Method Editor should now look something like this.

B. Create a method with UNICORN 6 and above
B.2 An example of using the Method Editor
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Nested block: Stable differential
pressure (Delta P)

This block ensures that a stable Delta P value is reached.

Step Action

1 In the Text Instructions tab, select the Block →PARAMETERS_CONCEN-
TRATION instruction of the Phase →Fed Batch Concentration phase.

B. Create a method with UNICORN 6 and above
B.2 An example of using the Method Editor
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Step Action

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Other and Block.

• In the Parameters for field, type an appropriate name, for instance
STABLE_DELTA_P.

• Click Insert.

The new block will be placed inside the Phase →Fed Batch Concentration
phase.

Instruction: Setting Delta P value

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Block →STABLE_DELTA_P block.

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Recirc and DeltaP.

3 In the Parameters for field, set Setpoint to an appropriate value, for
instance 1.5 bar.

4 Click Insert.

Instruction: Setting Delta P
variations

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Block →STABLE_DELTA_P block.

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Specials and DeltaP_WatchPar.

3 In the Parameters for field:

• Set BaseLine to for instance 0.1 bar.

• Set MinPeak to 0.00 bar.

4 Click Insert.

B. Create a method with UNICORN 6 and above
B.2 An example of using the Method Editor
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Instruction: Setting Delta P watch

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Block →STABLE_DELTA_P block.

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Watch and Watch.

3 In the Parameters for field:

• Set Signal to DeltaP.

• Set Test to Stable signal.

• Set Minutes to 1.0.

• Set Action to End block.

4 Click Insert.

Set block end time

Change the block end time to 10 minutes to give Delta P some time to stabilize.

Step Action

1 In the Text Instructions tab, select the End_Block instruction of the Block
→STABLE_DELTA_P block.

2 In the Instruction Box, set Breakpoint to 10.00 min.

3 Click Change.

Nested block: Trans membrane
pressure (TMP) setup

This block sets the TMP value.

Step Action

1 In the Text Instructions tab, select the Block →STABLE_DELTA_P instruc-
tion of the Phase →Fed Batch Concentration phase.

B. Create a method with UNICORN 6 and above
B.2 An example of using the Method Editor
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Step Action

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Other and Block.

• In the Parameters for field, type an appropriate name, for instance
TMP_START_STOP.

• Click Insert.

The new block will be placed inside the Phase →Fed Batch Concentration
phase.

Instruction: Setting the TMP value

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Block →TMP_START_STOP block.

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Recirc and TMP.

3 In the Parameters for field, set Setpoint to an appropriate value, for
instance 1.00 bar.

4 Click Insert.

Instruction: Set the permeate
totalizer watch

Step Action

1 In the Text Instructions tab, select the Base →SameAsMain instruction of
the Block →TMP_START_STOP block.

2 In the Instruction Box:

• Set Breakpoint to 0.00 min.

• In the Instructions: list, select Watch and Watch.

B. Create a method with UNICORN 6 and above
B.2 An example of using the Method Editor
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Step Action

3 In the Parameters for field:

• Set Signal to FIT142VTot.

• Set Test to Greater_Than.

• Set Value to volume of permeate.

• Set Action to End block.

4 Click Insert.

Set block end time

Change the block end time so that the tank level has time to reach the volume set in
the tank level watch.

Step Action

1 In the Text Instructions tab, select the End_Block instruction of the Block
→TMP_START_STOP block.

2 In the Instruction Box, set Breakpoint to a suitable time, for instance
60.00 min.

3 Click Change.

Progress review
If all the steps described above have been performed, the Method Editor window
should now look something like this.

B. Create a method with UNICORN 6 and above
B.2 An example of using the Method Editor
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If any step appears to be missing, misplaced or carries incorrect values, use the various
editing methods available in the Method Editor to correct the errors.

B. Create a method with UNICORN 6 and above
B.2 An example of using the Method Editor
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B.2.6 Saving the method

To save the method, click the discette icon or select File →Save in the menu.

B. Create a method with UNICORN 6 and above
B.2 An example of using the Method Editor
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Appendix C

Evaluation for UNICORN 5

Associated documentation
This section is only valid for UNICORN 5. There is no corresponding evaluation function
for UNICORN 6.

The use of the Crossflow Evaluation module in UNICORN 5 is described in detail in
the User Reference Manual - UNICORN 5.1 - Evaluation for Cross Flow Filtration.

Opening the evaluation module
In UNICORN Evaluation click the Membrane System Evaluation icon.

The Operation dialog is displayed.

C. Evaluation for UNICORN 5
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Main functions

Function Usage

Any vs any Generates a plot of any combination of process data collected
during a run. The process data could be for example detector
signals, flows, flux, and pressures.

Process
optimizatio
n

Creates a graphical analysis of process optimization run(s). For
example a process optimization to find an optimal flux as a func-
tion of TMP.

The image above shows an example of process optimization.

Evaluation example

The example is a result from a run with up to three different cross flows in the same run.

Step Action

1 Select a preferred process result, Found chromatograms are displayed.

2 Check the box Bundle chromatograms, the Chromatogram groups will be
displayed to the right.

3 Check the box for the first chromatogram, e.g. “crossflow 1” and click the
New data group button.

4 Check the box for the second chromatogram, e.g. “crossflow 2” and click the
New data group button.

C. Evaluation for UNICORN 5
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Step Action

5 Repeat the procedure until all chromatograms have been selected as
groups.

The displayed dialog should now look something like this:

6 Click Next to continue the evaluation.

Normalized Water Flux
Use this function to get normalized Water Flux values calculated. The results can be
used to maintain long term analysis of the filter recovery.

The image shows an example of plotted Normalized Water Flux.

Capacity plots
Use this function to create a graphical analysis of the filter capacity during a filtration.

C. Evaluation for UNICORN 5
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Appendix D

PID control and feedback tuning

About this chapter
This chapter provides information to enable users to set up a satisfactory control
behaviour of the UniFlux 10 by being able to understand and use the PID control func-
tions provided by UNICORN.

In this chapter

Section See page

D.1 Introduction 240

D.2 Using PID control 242

D.3 More information 243

D. PID control and feedback tuning
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D.1 Introduction

Illustration

This illustration shows the behaviour of the P, I and D components of a typical PID
process control regulator.

• Process is the process to be controlled.

• Time is elapsed time.

• sp is the "set point" where the process should operate.

• te is a point in time where the process is disturbed and the regulator will act.

• vp is the process value.

• P (orange) is the proportional component of the regulator.

• I (cyan) is the integral component of the regulator.

• D (purple) is the derivate component of the regulator.

PID parameter description

Parameter Meaning Behaviour Usage

P Proportional Guides the process to
its setpoint with an
input that varies
proportinally to the
error.

Reduces the effect of an error but does not
completely eliminate it. A simple P-regu-
lator results in a stable stationary error
between actual and requested flow or
pressure.

• Too large P-component will make the
system unstable.

• Too small P-component will make the
regulator slow and prevent it from elim-
inating the error entirely.

D. PID control and feedback tuning
D.1 Introduction
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Parameter Meaning Behaviour Usage

I Integrating Samples the error
over time and rein-
forces the regulator
output as long as the
error is not elimi-
nated.

The I parameter eliminates the stationary
error, but results in a slight instability
leading to oscillations in the actual flow or
pressure. The I parameter can have values
between 0 and infinity.

• Too large I-component will cause the
system to oscillate after the error has
been eliminated.

• Too small I-component will prevent the
regulator from eliminating the entire
error.

D Derivating Delivers an inital
"kick" to the regulator
with an amplitude
that is proportional to
the error change rate.

The D parameter can reduce the oscilla-
tions introduced by a PI-regulator. D can
have values between 0 and infinity.

• Too large D-component may cause the
system to overshoot initally and make
the system sensitive to noise.

• Too small D-component may cause for
the system to respond slowly to errors
and possiblly oscillate.

D. PID control and feedback tuning
D.1 Introduction
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D.2 Using PID control

Usage in UNICORN for UniFlux 10
Whenever an automated process step requires the control of pressure (feed, retentate
and permeate pressure), the UNICORN control software of UniFlux 10 employs PID-
type controllers to control the pressure to its setpoint.

The controllers for the feed pump and the trans membrane pressure (TMP) may require
adjustment depending on the type and behaviour of the filter.

The I parameter can have values between 0 and infinity. Smaller values have a greater
effect and a value of infinity has no effect. Note: The value infinity is set as 9999 in
UNICORN.

Most often, a simple PI-regulator is preferable for control of pressure, and UniFlux 10 is
therefore configured by default with the D parameter set to zero.

Setting up feedback tuning
UNICORN uses so-called PI feedback tuning, where P and I are parameters that deter-
mine the tuning characteristics.

There are two ways to apply the feedback tuning instructions:

• In the Method Editor module.

• In the System Control module, reached with the commands Manual or System
Settings.

D. PID control and feedback tuning
D.2 Using PID control
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D.3 More information

Introduction
This section describes tuning and adjustments and related troubleshooting.

Tuning the PID parameters
If tuning of the PID control is required, it is most likely that control settings for feed
pump or permeate pump need to be adjusted.

Common methods for PID optimization (e.g. Ziegler-Nichols method) can be applied.

Faster and slower response

Condition Then do the following...

If slower, more stable control is required Increase I

Decrease P

If faster (less stable) control is required Decrease I

Increase P

If the system tends to overshoot intially Decrease D

If the system tends to keep on oscillating after
the error has been eliminated

Decrease I

Decrease P

Increase D

Adjustment rate
No drastic changes should be applied.

An appropriate measure is to change the I parameter by a factor of 0.5 or 2, respec-
tively, while initially keeping the P parameter constant.

Faster regulation required
When optimizing the parameters to obtain a faster regulation, a recommended start
may be to do the following:

• Decrease I parameter by dividing with 2.

• Increase P parameter by multiplying with 1.2.

More stable regulation required
When the regulation is too fast, for example noisy curves, it may be necessary to opti-
mize the parameters in the opposite way, i.e., increase I parameter and decrease P
parameter.

D. PID control and feedback tuning
D.3 More information
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Troubleshooting

If the
parameter...

Is too... Consequence

P Large The system will become unstable.

Small The system will respond slow to errors and possibly be
unable to eliminate errors completely.

I Large The system will oscillate after the error has been elimi-
nated.

Small The system will be unable to eliminate errors
completely.

D Large The system will overshoot initally when regulating for
errors.

Small The system will be prevented from increasing the P-
component enough to achieve fast response without
resulting oscillations.

D. PID control and feedback tuning
D.3 More information
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Abbreviations, 10
Accessories, 166
Alarms, 216, 217

filter pressure, 216
TMP alarm, 217

Ambient environment, 79
Automation, 38

B

Battery limits, 151
pneumatic, 151
power, 151
process, 151

Block, 204
method editor, 204

Breakpoint, 206
method editor, 206

Breakpoint, method editor, 173
Buttons, 206

method editor, 206
Buttons, method editor, 173

C

Calibration, 132
other components, 132

Capacity, 147
CE, 158

conformity, 158
marking, 158

Checks, 112
final before start, 112

Chemical resistance, 153
Cleaning, 121, 122

cleaning agents, 121
external surfaces, 122
general, 121

Cleaning performance, 123
extended, 123

Component descriptions, 71
flowchart, 71

Compressed air, 79, 88
Conductivity, 143

troubleshooting, 143

Conductivity probe, test, 131
Conductivity sensor option, 52
Conductivity sensors, 66
Connections, 39, 91

power supply, 91
Create a block, 205
Create a method, 212
Create a phase, 204
Cross flow filtering, 142

troubleshooting, 142

D

Decontamination, 155
Dimensions, 146
Disassembly, 128

other components, 128
Disposal of electrical components,
155
Disposal, general instructions, 155
Documentation, 9

Software, UNICORN, 9
System specific, 9

Draining, 62
hollow fibre cartridges, 62

E

Electric cabinet, 37
Electrical power, 79
Emergency, 25, 27

procedures, 25
restarting the system, 27

Example, 210
create a method, 210

Explosive environment, 14
precautions, 14

F

FCC compliance, 161
Features, 208

method editor, 208
Fed batch concentration, 224
Feed pump, 41, 90

protection, 90
Feed tank, 46
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Filter area setting, 214
Filter area, setting in method, 182
Filter cassette holder, 56
Filter cassette installation prepa-
rations, 104
Filter cassettes, 58
Filter integrity test, 45
Filter pressure alarm, 216
Filters, 90

protection, 90
setup, 90

Flammable liquids, 14
precautions, 14

Flow sensors, 65

G

General precautions, 12

H

Holdup volume, 110
Hollow fiber cartridges, 103

installation, 103

I

Illustrations, 30
Important user information, 7
Installing and moving, 15

precautions, 15
Instruction Box, 206
Instructions, 207

method editor, 207
Instructions, method editor, 173

L

Labels, 23
Safety labels, 23

Layout, UniFlux 10 system 10, 30
Leakage test, 105

M

Maintenance, 20
precautions, 20

Maintenance schedule, 117
Manufacturing information, 157
Mass measuring, 109, 131

calibration, 131
preparing, 109

Mass sensor, feed tank, 68
Material compliance, 29
Media supply, 79
Membrane area, 216
Meter range and calibration, 111
Method, 212, 218, 235

create new method, 212
product transfer, 218
save method, 235

Method creation, 211
preconditions, 211

Method creation, pre-conditions,
178
Method Editor, 171, 173, 204, 206

Blocks, 171
Instructions box, 173
introduction, 204
phases and blocks, 204
text pane, 206
Text pane, 173

Method instruction, modify, 177
Method optimization, 166
Method, creating, 179
Method, creating new, 179
Method, fed-batch concentration,
191
Method, initial conditions, 182
Method, product transfer, 185
Method, save, 178, 201
Method, saving, 201
Mixer, feed tank, 53
Modify an instruction, 210
More information, 166
Multiple inlets option, 49

N

NFF, 98, 99
reasons, 98
sample handling, 99

NFF, recommendations, 98
Notes and tips, 8

O

On site service, 167
Operating limits, 147
Options, 47

about, 47
Ordering information, 166
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P

Parameters, 207, 208
instruction box, 208
method editor, 207

Parameters, method editor, 173
Peristaltic pump, 143

troubleshooting, 143
Permeate, 43
Permeate outlets, 219
Permeate pump option, 48
Personal protection, 14
pH, 144

troubleshooting, 144
pH calibration, 129

required equipment, 129
pH sensor option, 51
pH sensors, 66
Phase, 204, 214

method editor, 204
method settings, 214

PID, 242–244
faster regulation, 243
more stable regulation, 243
setting up feedback tuning,
242
troubleshooting, 244
tuning and adjustments, 243

PID control, 242
usage, 242

PID, parameters description, 240,
241
Power failure, 26
Power supply, 18, 91

precautions, 18
Prerequisites, 8
Pressure alarms setting, 214
Pressure alarms, setting in
method, 182
Pressure sensors, 64
Procedures after usage, 114
Product return or servicing, 168
Product transfer, 218
Purpose of this manual, 6

R

Recirculation loop, 219
Recycling of hazardous
substances, 155
Reference information, 145
Regulatory information, 156

Repair and calibration, 131
Restart after emergency, 27
Retentate, 42
Rinsing, 123

after CIP, 123

S

Safety labels, 23
Safety notices, 8
Safety precautions, 12
Save a method, 211
Sensor tagging, 69
Service, 166
Signals, 150
Skid, 36
Space and floor load, 79
Spare parts, 166
Start, 101

UNICORN, 101
UniFlux 10, 101

Storage, 125, 126
long-term, 126
short-term, 125

System, 28
description, 28

System operation, 18
precautions, 18

T

Tank level watch, 222
Temperature sensors, 67
Text instructions, 206
TMP alarm, 217
Totalizer, 208
Training, 166
Transfer feed pump, 222
Transfer pump option, 48
Transport, 81

in the crate, 81
Transport, unpacked, 81
Troubleshooting, 138
Typographical conventions, 6

U

Undo function, method editor, 174
UNICORN, 9, 74, 75, 77

Alarms, 77
control system, 74
Documentation, 9
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overview, 74
prerequisite, 74
software modules, 75
system networks, 74
Warnings, 77
work flow, 75

Unpacking, 82, 83
procedure, 83
tools required, 82
visual inspection, 83

User allowed actions, 127
UV monitor option, 50
UV sensors, 66

V

Variables, 208
instruction box, 208

W

Weights, 147
Wetted materials, 166
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